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:HOFRPH�WR�:LQ3&6,*1���������������������������������������������������������������������������������

�
,QVWDOODWLRQ������

�

�� Be sure to close all open programs and insert the CD-ROM program into the CD-ROM or DVD drive.  
   If the autorun is active in your computer you will see the following screen.  

  

���������������� If the autorun doesn’t start, select   from WinPCSIGN CD-ROM / 3UR folder.�

�� Security key installation (dongle). 

 
�
���Run WinPCSIGN  
�

�
�

 
  

Double click the WinPCSIGN icon from your desktop or select 6WDUW���$OO�3URJUDPV���
:LQ3&6,*1�
 

You can insert the security key RocKey2 anytime, no driver to install or 
search, just place the security key (dongle color may vary) in a USB port. 

If you wish to install WinPCSIGN Pro, click 1H[W button�to 
install WinPCSIGN. We recommend to select 7\SLFDO 
installation.                      
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6HWWLQJ�D�FXWWHU 
�
+RZ�WR�VHW�\RXU�FXWWHU�

�
 
Before proceeding to the configuration this information will be necessary 

 
1) Cutter brand name and model 
2) Type of connection 
3) USB cable or cable supplied with cutter 
4) USB driver. 
 

     Select &UHDWH 1HZ�GRFXPHQW� then From File menu select Plotter code or select it from the 6HWWLQJV�
PHQX / 3ORWWHU�&RGHV. Then from the 6HWXS�3ORWWHU screen click $GG�5HPRYH  

 
 
 
Locate your plotter, select it and click on the arrow to DGG�to place the plotter in the visualization windows 
to the right. Click 2. button and select a FRPPXQLFDWLRQ�3RUW�
 
 +RZ�WR�FRQQHFW�\RXU�SORWWHU�XVLQJ�D�VHULDO�FDEOH"��&RP�SRUW��

 

 If you use a serial cable between cutter and computer, use the Com port available, usually Com1. After Com  
 port is selected, click on $FFHSW�6DYH�button. 

 Use the available &RP�SRUW�previously identified in the 'HYLFH�0DQDJHU. If you use a USB serial converter  
 check the new port in the :LQGRZV�'HYLFH�0DQDJHU�3RUW and configure your cutter with the new port. 

 +RZ�WR�FRQQHFW�\RXU�SORWWHU�XVLQJ�DQ�86%�FDEOH"
 

If your cutter is configured to a USB port, click the button 6HOHFW�86%�SORWWHU�to select the proper USB printer 
or FTDI driver 
 

 
 

LI�\RXU�86%�GULYHU�LV�QRW�LQ�WKH�OLVW�����
�

A) Insert the Cd-Rom driver  
B) Plug the USB cable   
C) If you don have driver, download driver from web site  

              D) Select 5HIUHVK�button 
              E) Download from internet 
              
             Click the 2. button to close the USB port selection window and click the $FFHSW�6DYH button. 

�
�

� �
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 7HVW�WKH�HTXLSPHQW�
 
Draw UHFWDQJOH near left hand bottom corner; this represents The origin point (0,0). Click on the &XW�3URMHFW�
LFRQ, this will open the &XWWLQJ�&RQWURO�3DQHO  

�

�
��

 
From the &XWWLQJ�&RQWURO�3DQHO check Material value, select Weeding, Advance and press: 
6WDUW���Watch�a�video 

 

�
�
5HDG��&XW�\RXU�ILUVW�MRE�FKDSWHU��3DJH�����
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7R�HQKDQFH�WKH�FXWWLQJ�RI�TXDOLW\�
�

 
Click the 2SWLRQV�EXWWRQ from &XWWLQJ�&RQWURO�3DQHO���Enter a value of 0.12 or 0.15 for the ZHHG value.  
Also FKHFN�PDUN the box or 6WDUW�3RLQW�2ULHQWDWLRQ�and�6DYH�PDWHULDO. 

 

     
 

Click 2. button and exit from Cutting Control Panel so that the changes take effect 
�
%DG�YDOXH�RI�D�.QLIH�RIIVHW�H[DPSOH��                                   �

 

 
 

 The EODGH�RIIVHW function allows you to compensate for the slope of the edge of the blade. The advantage 
of choosing a good offset value is that letters have square corners and are easier to weed because the vinyl 
and adhesive will be totally cut. 10 units   offset = 0.50 mm = 0.020 inch 

*RRG�.QLIH�RIIVHW�YDOXH�ZLOO�JLYH�\RX�D�JRRG�FXWWLQJ�UHVXOW��7KLV�YDOXH�LV�DOUHDG\�VHW��\RX�
GRQ¶W�QHHG�WR�FKDQJH����  
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6WDUWLQJ�RXW�
 

Your WinPCSIGN Pro software is now ready and you are impatient to discover the many capabilities of the 
software, however you will need a certain time to get acquainted with the software and the equipment.  
 
After the WinPCSIGN Pro software installation a new icon will be created on the Windows desktop. 
 Double click to open WinPCSIGN Pro: 

 

 
 
WinPCSIGN open first screen. From here you can: 
 

$��&UHDWH�D�QHZ�GRFXPHQW�
%��2SHQ�DQ�H[LVWLQJ�GRFXPHQW�
&��7UDLQLQJ�PXOWL�PHGLD�WXWRULDO�
'��$FFHVV�RXU�ZHEVLWH�

            ���������������������������������������������������������������������������������������������������������������� 

�
6HOHFW�&UHDWH�D�QHZ��EODQN��GRFXPHQW��
�
If you select�QHZ�GRFXPHQW .the “6LJQ 3DJH” screen appears  Enter /HQJWK�and +HLJKW of your sign 
or the dimension of your material (vinyl) putting on the cutter. Click “2N” 

 
 

 
 

���6DYHG�VLJQ�SDJHV�
���(QWHU�QHZ�VLJQ�SDJH�/HQJWK�	�+HLJKW�
���6HOHFW�8QLW��,QFKHV��FP�RU�PP�

 
              
            Watch Welcome to WinPCSIGN video 
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 :HOFRPH�WR�ZRUNLQJ�VFUHHQ��
 

 
 

The “working screen” represents your page according to the selected dimension and orientation of your 
sign or the material putting on the plotter. You will also see the tools bar, the color palette, function bar 
and, on top of your screen and zoom bar at bottom of the screen  
�
&RPPDQG�%DU��

�

                 

  

New document ( control +N ) 
 
Open a document   (Ctrl + O) 
 
Save as a document (Ctrl + S) 
 
Cut   (Ctrl + X) 
 
Make a copy (Ctrl + C) 
 
Paste (Control + V) 
 
 Print 
 
 Open Cutting control Panel ( F10) 
 
 Redraw . Refresh your working screen ( F5) 
 
 Fonts. Open the windows fonts. 
 
 Undo.  Recuperate delete job (control + Z) 
 
 Redo. Redo the last action(s) (control +R) 
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7RROV�%DU� 
 

 

 
 

 

�
7UDQVIRUPDWLRQ�VFUHHQ��

 
The transformation tool is specially used to modify or to compare position, height, width, condensation, slant, 
mirror effects, rotation and engraving functions of any selected objects or groups. This exceptional tool bar is 
opened by default. You can also press the letters H,W,P,C  from your keyboard to open.  

�. Select Element: Tool for selecting of one or more 
element(s). (Select, move, and resize an element(s)) 
��.Manipulate: (F9) The manipulation tool is use to move 
points or to convert an arc into a line or a line into an arc 
�.Text Tool:  select “text tool” then move your cursor on the 
working screen and click. Type your text. 
�.-Segment: Use to draw lines automatically connected. To 
use this tool, move the mouse on your working screen, click 
and drag. Release the mouse button to create your first line, 
move the mouse and click to connect to the first line continue 
this action. 
�.Arc from a path: Use to draw connected curves 
. 
�.Free Hand Draw: Free hand draw traces a smooth path and 
closes  the path by connecting the two extremities of your 
path. 
�. Oval:  draw ovals or circles. 
�� Rectangle:  draw rectangles or squares. 
�. Merge: This command is used to merge an element to an 
image. (Alt + S) 
��.Image Contour: To create exterior or interior contour of an 
image allowing   to cut the contour  
 

��.Justification: Brings up the justification tool 
bar to align the text and the various elements 
selected to  
the center, left, right, top or bottom. 
��. Line Dimension: Open the line dimension 
window to create dimensions-lines and 
measures. 
��. Zoom: Use to zoom in closer to your page, 
open the  zoom window 
��.Erase: Use to erase line(s), curve(s) picture. 
(F5) Note: You can also use the “Delete” from 
your keyboard. 
��.Brush color: Color using the selected brush 
color. 
��.Color palette: To display or hide the Color 
palette. 
��. Pen/Brush: Opens the Pen/brush 
configuration 
��.window calculator: Opens a calculator 
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�

����$FFRUGLQJ�WR� You can select the rotation axis or the mirror plan to make a transformation. 
���,QFUHPHQWV: This represents a value that you wish to add or  
to decrease the position X and Y, the width, the height, the condensation, the inclination angle, the rotation 
angle in degrees and the engraving. 
����&DQFHO� This option cancel (undo) the last action. 
����'XSOLFDWH�  create a copy of any selected object or groups. 
���$SSO\�  Apply selected transformation to the selected objects or groups. 1RWH�. Not recommended for text 
height.��   

&RORU�SDOHWWH:          

3HQ�&RORU��The pen color or the edge of an object is what is cut out; it does not affect the fill color or color 
inside an object. (Brush color).   

 

 
 
Click arrow to expand additional features in the color palette.  Allow transforming the outline color of an 
object selected with the same color as his fill color. Click on arrow to expand the color palette or to return the 
palette to its previous size. 
 

� �

���7UDQVIRUP��Indicates which tool is 
selected and used. 
���3RVLWLRQ�DV�;�DQG�<� Represents the 
position of the selected object. On the 
image we see a position giving to X a 
position of 2.5 and giving to Y a position 0.0 
(zero). You can modify these values by 
typing the desired values in the window. 
Scroll buttons can be used 
���$QJOH�  This represents the rotation 
angle in degrees that you wish to rotate an 
object or the inclination (slant) angle. 
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&RORU�VHOHFWLRQ� 
 
 

 
 
 

 
 
 

�&RORU�%R[���
�

� �
�

�%UXVK�	�3HQ�6OLGHU�

�

�
                           �
�
)LOO�&RORU�  
The fill color or color inside an object. (Brush color). 
 

     
 

 
7H[WXUH�/LEUDU\: Bazzil-Heat transfer vinyl-Rhinestone-Granite-Marble and more 

 

You can use this texture to fill your selection  

By selecting an object and moving the mouse cursor 
on a color of the palette, you will obtain a fill color if 
you press the left mouse  button, and a pen color if 
you use the right mouse button.�

   Moving the mouse cursor over a color  
   of the color box, you can select a  pen or                     
  fill  color for any selected object. 

These bars show what colors are currently selected for 
your brush (fill) and pen color (border). Clicking the “X” 
boxes will make the fill color or the pen color invisible. 
“X” are colored in red to show that they are not visible. 
 

If you created a contour cut, around an image, you 
need to select this color if you want to export it. 
We recommend export your files in EPS. 
 
Click arrow down �
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�5HJURXSHG�DGGLWLRQDO�WRROV������            
 

 
 
2XWOLQH�

 
From 7RROV menu expand and select 2XWOLQH� 

 

 
 

The window transformation contains four tools, the first tool allows to create external and / or internal 
contours around a text or a logo thickness��You can create one or more spaced external contours of 
adjustable                                                                                                            
                                          
 
��7KLFNQHVV��Select the thickness of your Outline. Always use a low value like 0.10 or 0.25. inches  
1XPEHU��Select how many outlines you want. 
 
��2XWOLQH���,QOLQH� Outline is towards the outside of the design object while inline is towards the inside of the 
design object. Remember that the number of inline contours is limited by the 
 size of the object. 
 
��&RQWRXU� This function automatically welds the overlapped objects, select contour to make any 
overlapping outlines automatically weld together. 
 
��*UDGLHQW� Generate a color background made up according  to the gradient of filling selected. 
 
��%UHDN�7H[W� This activated function separates the original text from the outline created when not activated; 
the initial text and outline created are grouped units and inseparable. You must  break the text if you wish to 
create two or several outline of various thickness or different colors. 
 
��6RUW� Arranges stacking order of the outlines generated in order to show the smallest object on top of the 
pile. 
 
��)LOO�&RORU� Displays the current outline color selected. 
 
��&RUQHU�6W\OH� Select from three model styles of generated outline corners. 
 
��$SSO\� Apply your current setting to generate outline(s).      
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�'LVWRUWLRQ���
�

Write your text, select it and from the Tools menu expand and select 'LVWRUWLRQ or from keyboard use 
(Ctrl+K) brings  up a window with distortion templates to transform your  selection. 

     
 
 

       
 
 
 
 
 
 
 
 
 
  

1. - Select forms from preset distortion. 
 
�����7\SH�RI�'LVWRUWLRQ� Select “FreeHand” or 
“Use Form”. 
 
�����%R[�/LQH�W\SH���%R[�RU�&XUYH�� Select Box 
with curves, the selection with curves allows 
handling of curves. 
 
�����:RUN� keep the lines or to convert the 
lines into  curves. 
 
���1XPEHU�RI�3RLQWV� Select � or � points. 
Four additional bounding boxes appear. 
���&DQFHO���$SSO\�   
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0DNLQJ�\RXU�ILUVW�SURMHFW 

6WHS���
�
�2SHQ�:LQ3&6,*1�IURP�,FRQ���7KLV�VFUHHQ�VKRXOG�DSSHDU��VHOHFW�³&5($7(�1(:�'2&80(17´ 
 

 

6WHS���
�
A new screen will appear where you can select your page size or define a new working page 
and choose metric or English units. (You can change the dimensions of your working page 
anytime.)  Select the SDJH�VL]H�WKDW�you wish to use and select ³2N´. 
For this project select the 24” x 24” then select “Ok”. 

� �

�

7ZR�ZRUNLQJ�PRGHV��
To configure the working page according to the dimensions of the sign to be realized  To configure the 
working page according to the width of the vinyl used to avoid losses, to choose a arbitrary length page of 
2 or 3 times the width of the vinyl. Do not to forget to choose unit of measure. 
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6WHS���
�
�
The working screen appears, read Tip of day, close or select do not Show Tips anymore. 
 

 
 
 

6WHS���
�
/HW¶V�DGG�D�VLPSOH�WH[W�
�
�
D��From the Tool Bar on the left side of your working screen, select 7, the Text icon.    �

�
E��Once selected, the 7 icon move the mouse on the working page and click on the place where you 
wish to begin to write your the text. 
 
F� Type in “+HOOR”, the text should appear on your working screen. 
 
G� Select a color from Color palette using left click mouse 
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6WHS����

By means of the mouse click the selection tool in the tools bar at your left, click the text which you typed, 
eight small black boxes appear around your text; this indicates that the object +HOOR�is selected. 
 
To change the font or the height of the font, click the icon )�at the top of your working screen. 
 

 
 

The height of the font is defined with the letter H capital letter of the alphabet. This menu allows to use the 
cutting fonts and the True Types and Adobe fonts present in your computer. Furthermore it allows changing 
height. 

 
                                                                                                         
������������6WHS�����7UDQVIRUPDWLRQ�0HQX�

 
 
Press the letter + to open the transformation bar and compare the heights.�

�
�

 
 
 

Transformation tool , measure the box, round letters is bigger. The transformation tool measures the 
selected object; it is the measure of the box of the selected objects. 6R�IRU�WKLV�UHDVRQ�ZH�UHFRPPHQG�
WR�HQWHU�WKH�UHDO�VL]H�RI�\RXU�WH[W�LQ�)RQW�PHQX��

�
If your cutter is configured, you can cut now. For this prepare your cutter, power ON, vinyl and... Click the 
blade icon which opens the cutting control panel keyboard and  
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&XW�\RXU�ILUVW�MRE�
 

  

 
 

���� 
            

 

�&KHFN�LI�WKLV�RSWLRQ�LV�RIIHUHG�E\�\RXU�SORWWHU� �

�. Cutter selection (if 2 or more available) 
 
 
���Cutting or pen speed selection��
�
���Blade pressure if cutter has this function�
�
�. Material, enter real vinyl height. Effective vinyl width value. 
 
�. Weeding box activated or not  
 

�. Movement of the plotter head of  to the end or at the beginning of the vinyl. 
 

 
�. All Colors. Allows cutting by color selection of 1 Allows cutting objects by the  
color. You can modify the color outlines by selecting objects and to apply the function 
to use the filling color as for the outlines color.   
 
 
�� Selected object. Select the object  that you want to cut then select the function. 
�
�
�. Show me. Verify the vinyl alignment 
 
 
10. Start. Send your job to the cutter 
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*UDSKLFV�VRXUFH�DQG�9HFWRUL]DWLRQ��
 
���,PSRUW�IURP�D�VDYHG�JUDSKLFV�ILOH��
���&RS\�DQG�SDVWH�JUDSKLFV�RU�LPDJH�IURP�LQWHUQHW��
���6FDQQLQJ�JUDSKLFV��

 
1-You can import image into WinPCSIGN by XVLQJ�)LOH�0HQX��,PSRUW��DQG�,PDJH. Or keyboard (Ctrl + I) 
 

 
 

 
2- From another program showing a graphic on the screen, or from a Web site, you can use the right mouse 
button to copy the selected graphic and paste it afterward on your WinPCSIGN Pro working screen. Use the 
right mouse button to copy or paste a graphic or use the keyboard (Ctrl + C) to copy and Ctrl + V) to paste. 

                                                             

3- From a scanner, place your graphic in the scanner. 
 

a) From the file menu, select the source and locate your scanner you will only need to do this the first time 
you use a scanner. 
 

 
 

                                                                            
When digitizing your image - use the scanner functions to enlarge the image as much as possible. The 
larger the image, the better the conversion will be. You can scan in color at 256 colors, 8 bit, 16 bit, or 24 
bit 

 
Parameters to use: 
 - Black or Color drawing (Solid colors only)  
-  Enlarge the selected zone as much as possible   200 to 800 %  
 - Scan using 150 or 300 dpi 
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7R�EHJLQ�WKH�DXWRPDWLF�FRORU�YHFWRUL]DWLRQ�
 

Step 1 :  Import , Paste from internet or scan an image. 
 

 
 
The quality of your image will affect the results. An image taken from a Web site is often of poor quality, and 
most of the time is too small to generate a good conversion. If your image presents gaps: 
 
1) Size of the image is lower than 2 inches. 
2) Visual quality is 72 or 96 dpi 
3) Image shows stair like borders. 

                                  

Step 2:  If your image shows lot of pixels, use our�LQWHUSRODWLRQ tool, from %LWPDS�PHQX this features 
allowing increasing the size and quality of your image. 

 

  
 

The resizing (blow up) factor of the image maybe from 2 to 20 times the original size. If your image size is 
1/8 inch, a factor of 20 will be normal. 

 
 

             Watch a video  
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Step 3:   Begin the automatic color vectorization. 
 

From the Bitmap Menu select 9HFWRUL]DWLRQ / $XWRPDWLF� 
 

 
 
 
 
WinPCSIGN open Vectorization screen. From this screen you can select Bezier, Enhance curve 
and Corner. These functions can analyzing an image and give the best conversion.  
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  6HOHFW�WKH�ULJKW�YHFWRUL]DWLRQ�RSWLRQ������             
�

 

  
 
 

 
 

                                  
� �

�. Detect Intensity: Allows to increase or to remove colors or  tints or allows to increase 
the tint or to increase strength of one or several colors. 
 
 
�. Color Resolution: Allow reducing the number of bits by successive steps from 24 bits 
to 1 bit per pixel. This tool transforms an image in a black and white picture. 
 
�. Make Vectorization: The magic wand applies the vectorizing. 
 
�. Apply on Selection: After vectorization you can select objects. The selected objects 
can be transformed into curves or into segments to obtain square corners. 
 
�.Erase the small object  

Bézier curves, force the quantity of curves and 
arcs, we can force the creation of sharp corners 
and lines. 

We can force the creation of sharp 
corners and lines. The first drawing the 
rose and the leaves are   made only of 
Bezier curves.  
 
The anchor is made with arcs and with 
lines it is the second choice “Enhanced 
curve”. 
 
Monuments  are made only of lines and contain 
very few curves in that case we choose 
“Enhanced corner”. 
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$GYDQWDJHV�RI�TXLFN�ZD\�
�

1- Conversion by keeping the number of colors wished normally the number of colors is from 2, 3 to 6 colors. 
2- One tool to be used is the magic wand. 

4XLFN�ZD\�FRQYHUVLRQ��
 
1 .From vectorization window select  “Bezier” , “Enhanced curve” or “ Enhanced corner”  
2. Use the Magic Wand tool and click on image. Vectorization will open Posterize option. Click RN 
3.Conversion process starts and generates a vector image on your screen. 
 
 

 
 
 After conversion you can erase colors, edit paths, select one or several objects and modify the parameters 
of conversion. An example generated paths are curves but the rounded off corners you need sharp corners. 
In that case: 
 
  
1) Select the paths to be modified 
 2) Select button “Enhanced corner” 
 3) Click the button “Apply on selection” 
4) Select W-curve option to smooth your path  
 
 

 
 
 
               Select the scroll bar left to right to start smoothing your vectorization result.     
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7KH�H[SHUW�PHWKRG
�

'HWHFW�LQWHQVLW\�YHFWRUL]DWLRQ�
 

          

 
Use the “Detect Intensity” tool and use the first slider to increase or decrease the intensity of colors  
Display mode:1:1 real scale Full screen (see full image 

 
 &RORU�UHVROXWLRQ                        

Use the “Color Resolution” tool and use  the  down arrow to select 1 bit,  decreasing  colors to 1 bit pixel 
( Black  & White).  Use the “Magic Wand” and click on the image to be converted 
 

 
 
A black and white image generates better quality during vectorization. Use these parameters:   
-Bits per pixel = 1  
-Dither method = none   
-Palette = Fixed  
-Palette Color Order = Blue-Green-Red. 
                                                              
After vectorization, objects can be modified by using   others conversion parameters. Check the vectorized 
objects shows that one or more converted objects need squared corners, a only use the “Select Elements” 
tool, select one or  more objects, click the option “  Enhanced corner” and click  the button “Apply on 
selection”. 
 
“Enhanced corner” forces objects to display sharp corners; if you use “Enhance curve” it forces objects to 
display curves, which means sharp corners become rounded. This feature is also good to vectorize texts. 
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)LOH�0HQX��������������������������������������
�

1HZ�
�

Create a new file 
 
This function will open 6LJQ�3DJH screen. Enter your desired size and select unit. 
 
2SHQ�

�
Open an existing file This function allow you to open a saved WPC file.   

:3&�ILOH�YLHZHU 

Simply go to File > Open... and the :3& window will open. Within the :3& window, simply make sure 
the (QDEOH�3UHYLHZ box is checked and then when you browse your computer and select a wpc file, it will 
automatically be shown in the lower part of the window.  You will see the file just as it would appear when 
opened in WinPCSIGN. 

You can now simply browse through your many, many wpc files to find just the right one, without opening 
each file 1 at a time to see what it looks like. And, it gets better! 

While you are browsing your wpc files, you can also easily and quickly delete or rename any of them.  
Simply select the file, wait a moment and click again 1 time directly on the file name.  The appearance of the 
file name will change from selected to highlight and you can then type the new name. Just be careful to not 
delete or change the .wpc extension.  You can also right click mouse the file name and select rename. 
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6DYH�

�
Save your files and changes. (WPC file)  
 
 If you want save to another kind of file. You need to select ([SRUW from File menu  
(ai,eps,pdf,dxf,plt,svg,pic)�
�
6DYH�DV�
 Save a :3&�file under new name 
 
�
$XWRPDWLF�EDFNXS
Create a backup of your selection.  To recuperate your backup files, select 5HFRYHU\ from File menu 

This function allows you to create automatic copy of your current job. The job will be saving in Backup folder:��
�
�&�?3URJUDP�)LOHV�?6LJQ0$;?:LQ3&6,*1�3UR�����?%DFNXS�

Procedure: 
Select 6HWXS from Setting Menu, then open 6DYH��dialog bar and select (QDEOH from $XWR�6DYH  and  enter 
the time that you want the software save your document.  Press Ok to save. 
 
 

 

�
�
�
�
�
&DSWXUH�6FUHHQ�

 
This function copies image and screen from your computer. 

      
It captures everything other than the WinPCSIGN. To see the image, simply go to the (GLW menu and click 
on 3DVWH��
�

   
 

Procedure:   
Open the screen that you want copy, then from file menu select &DSWXUH�6FUHHQ or press 
$OW���& from your keyboard. WinPCSIGN will automatic paste your capture.   
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,PSRUW�
 

Use the ,PSRUW command to load:  AI, PDF, DXF, EPS, PRN, DPF, WPC, TXT and images BMP, JPG files 
�

From the )LOH menu choose ,PSRUW�or press�&WUO���, from you keyboard and select the desired format 
from the import list:  
 

         
 
Procedure:  
�
From the )LOH menu, click on import and select the desired format. Click in the Look in window and you will 
see what drives are available. Click on the drive containing the file you wish to open. Select the folder 
containing your file. Click on your file, or enter its name in the File name area. Click  2SHQ.  

�
,PSRUW�(36�$,�3')��

Use EPS and AI to import files from other programs. From the )LOH menu, choose Import and select (36, $,. 
Select the desired file from the list and press 2., The program will show you the 9HFWRU�or %LWPDS�dialog 
box, click the desired option. 

 

 
 

Select 9HFWRU�if you want to plot or select %LWPDS�option if you want to print. 
 

�
                                           

If your logo contains PDF, WinPCSIGN will show you this message. We recommend that you select Yes, but 
if the file does not open, import again by selecting No. 
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([SRUW�

Use this option to export files to others programs. 

 
Keyboard��Ctrl + E�

�
Select the object(s) to export or use (Ctrl + A) to select all objects from your screen. From )LOH��click 
([SRUW. 

 

 
 

Procedure:  
�
1. Select object(s) to export 
2. From the )LOH menu, click on ([SRUW. 
3. Click in the Save in window, it will open up  and tell you what drives are available. 
4. Click on the drive where you wish to save your file. 
5. Click on the folder and subfolder where you wish to save  your work. 
6. Write the desired name in the File name area, followed by the format abbreviation ex: DXF and click 
sDYH. 

 
 
 

 
([SRUW�LQ�LPDJH�-3*��%03��31*��7,)«�

 
This function will enable you to determine the quality, size and color of the image. Every time you export a 
JPG file, a dialog box will appear. From the Image properties dialog box, select quality,  
resolution and color. 

 
The 4XDOLW\ option offers you three types of compression; minimum, average, maximum. A minimum 
compression will maintain the size and quality of the image. Maximum compression will save disk space but 
image quality will suffer. Average compression will reduce the size of the image, while maintaining an 
acceptable quality level. Upon making your selection, click 2. to confirm and &DQFHO to start over. 
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([SRUW�31*�)LOHV�ZLWK�7UDQVSDUHQF\
 

This function allows you to export a PNG file with a transparent background.  Images with transparent 
backgrounds are useful when you are not certain of the page background color on which your image will be 
displayed or you intend to display your image in front of a complex background rather than a single 
background color.  

Procedure: 

Create, Import or paste your image. Then from )LOH menu select Export ,PDJH��From Export screen, 
select 31* from 6DYH�DV 7\SH� Write the desired File name and select the desired folder on your computer. 
WinPCSIGN will show the following screen: 

�

1.- Select the Resolution ; and <�DPI.(we recommend 96 DPI for web and more than 150 DPI from printing) 
2.- Select 24 + Alpha transparency. 
3.- Select a desired white border value. If you do not want, please enter 0 (Zero). 
4.- Press 2.��and go to: &KRLFH�RI�WUDQVSDUHQF\�FRORU screen: 

�

Click 2. to save. To see the result, you need to import it from )LOH menu/,PDJH�31*���
To UHPRYH�WKH�WUDQVSDUHQF\, click your image and select the function from %LWPDS menu. 

�

�
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�

([SRUW�LPDJH�ZLWK�:DWHUPDUN�

A watermark is a recognizable image or pattern that appears as various shades of lightness/darkness when 
viewed by transmitted light (or when viewed by reflected light, atop a dark background), caused by  
thickness or density variations in the image��
�
Procedure 
Select your image then from File menu select Export , then chose JPG, BMP, PNG etc. From Bitmap 
properties, select Watermark Setup, write your desired text and color. Apply the desired % transparency 
using the slide bar, and press Ok and export it.����
�

 
 

 
([SRUW�(36�ZLWK�D�FRQWRXU�FXW�

�
This option allows you to export your design or image to your printing software with a contour cut.�
  
3URFHGXUH��&UHDWH�D�FRQWRXU�FXW��VHOHFW�LW��WKHQ�IURP�&RORU�3DOHWWH���FKRRVH�WKLV�VSHFLDO�FRORU� �
<RX�FDQ�DOVR�DGG�FURSPDUN�EHIRUH�WR�H[SRUW�LW��
��

 

�
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,QVHUW�EDWFK�/RJRV�RU�ILOH�LQWR�&OLS�$UW�PHQX

This function allows you to create groups of your logos or files and insert them to Local Clip. From File 
Menu, select ,QVHUW�%DWFK�&OLS�$UW�IXQFWLRQ. Then from logo classification screen select the option. 
WinPCSIGN will create a group in Local Clip Art 

 

�

�

�

�

�

�

�

�

�

�

�

6LJQ�0$;�/RJRV����

�$FFHVV�WR�/RFDO�&OLSDUW�
��
.H\ERDUG��&TRL + L 

From the )LOH menu, click on 6LJQ�0$;�ORJRV��This operation opens the database containing 
images and logos that are ready to cut or print. 
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'HVFULSWLRQ�RI�JHQHUDO�IXQFWLRQV�� 

 

 

 

  

 
 
 
 
  

�
 

  
           

             &UHDWH�D�JURXS�RI�ORJRV�ZLWK�D�GHIDXOW�LPDJH����
 
               Add:  selected elements to selected group.�

3URFHGXUH���
1.- On the software’s work page, select an elements or a drawing,  click on the /RFDO�&OLSDUW icon 
2.- the group of logos and click $''�RU�,QVHUW. The selected object will be added to the group. If needed, 
enter keywords in case you need to search for them later on, or press on (6&. 

Change  :  Enables you to change the image representing.  Possible image types: BMP and JPG. 
 

Conversion  :  Converts a group of logos coming from a previous version to the new version. 
�
1RWH��Certain functions are available at different places in the program, but they don’t necessarily 
work the same way. For example, the 3ULQW option is included in the general functions and in 
validation functions. 

            
 

�&KDQJH�ORJR�JURXS�QDPH��

To change the name of a group, you must first select it. Click on the left mouse button. Enter the new name 
and press (QWHU�  

 
7R�RSHQ�JURXS�RI�ORJRV�� 
 
To open a group of logos, you must double click the image representing the desired group. Once the group 
is open,  you are in selection mode. 

 
6HOHFWLRQ�PRGH���
�
Selection mode enables you to select a logo to be placed in the document, erase unwanted logos, or open 
the slide show or validations modes.  

 

 
 

� �

Close logos window and go 
back to WinPCSIGN 

Update database. 

Find logo 

Erase selected group 
of logos. 
 

Select sound 
 

Print group of logos 

         
 

Lock/Unlock logo 
group 
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'HVFULSWLRQ�RI�VHOHFWLRQ�IXQFWLRQV�
�

 

  
 

  
  
 

  
 

   
   
  

 1RWH��To select a logo, it must be selected with the left mouse button 
 
 
&URSPDUN 

 
Read contour cut chapter 
 

 
                                   

Return to general menu. 

Erase logo page or one logo in 
zoom  mode. 

Displays the next logo(s). 

Displays previous logo(s). 

Zoom selected logo 

Starts Slide show mode. 

Open validation mode. 
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&XW���3ORW�
�

Before running this option, you must configure your 3ORWWHU. Open the 3ORWWHU�&RGHV�in the 6HWWLQJ�PHQX�
and adjust the setup according to your plotter. Do not forget to check the communication port (USB,, COM1,  
COM2,LPT1,Windows port ).Baud rate (9600), data bits (8), stop bits (1) and parity (None).   
 
To open Cutting Control Panel, select�3ORW�from�)LOH�PHQX or select�&XW�3URMHFW�LFRQ��
�

�  
 
�.H\ERDUG��)���

 
*LYHV�\RX�DFFHVV�WR�WKH�&XWWLQJ�FRQWURO�SDQHO�EHIRUH�VHQGLQJ�\RXU�ZRUN�WR�WKH�SORWWHU��

 
Use this function to send a file to the plotter. Click with the mouse on the Send to plotter icon or select 6HQG�
WR�3ORWWHU from the )LOH�menu. WinPCSIGN will open the Cutting option menu .Once the menu is open, click 
on 6WDUW to begin cutting or drawing. If you  want to know how to cut by panels, read Cutting panel to 
description. 

If you want to cut a specific object from the page instead ofthe entire page, there are two possibilities. By 
changing the FRORU�of the pen to select the desired object, then from the 6HWWLQJ�menu choose 3HQ�&RORU. 
WinPCSIGN will display a color palette. Choose the desired color and click 2.. The object's color will 
change into the one you selected. 
You can also cut by selecting which object to cut from the drawing. In order to accomplish this, you must 
select the object with the mouse. Then you must go to the &XWWLQJ�FRQWURO�SDQHO and choose 6HOHFWHG�
2EMHFW to cut. Click on the desired color to select the object you want to cut, then move the object to the 
desired position (X, Y coordinates) and click on 6WDUW�to cut. 

 
&XWWLQJ�&RQWURO�3DQHO��

�

�
 
                                                  

7KH�&XWWLQJ�FRQWURO�SDQHO�RIIHU�WKH�IROORZLQJ�WRROV��

3ORWWLQJ�VSHHG�ZLQGRZ��
If you want to change the speed value, go to 3ORWWHU�&RGHV in the 6HWWLQJ  Menu, open Velocity and change 
only the number value. (Option 2 is cut fastest) 

$GMXVW�ZLGWK�RI�0DWHULDO� 
You must enter the maximum vinyl value setting on your plotter. If your drawing is bigger than your vinyl 
width, the program will show display your work divided in panels, (101,201…) Select one and click 6WDUW. 
:LQGRZ�WR�DGMXVW�NQLIH��SHQ��SUHVVXUH��This option is only for the PRO plotter series. 
 
&XW�E\�FRORU�VHOHFWLRQ�NH\�RU�$OO�FRORUV�VHOHFWLRQ�NH\���
This option allows you cut by PEN color selection. 
 
0LUURU�VHOHFWLRQ��
Used to apply a mirror effect to your work. (recommend to cut tshirt material) 
 
����URWDWLRQ��
Used to apply 90° rotation on your work. This function is recommend in combinations with Save material 
option 
 
:HHGLQJ, 
This function is used to create a border on your item. The width of the border can be modified in Options 
 
��3DVV Use this option to cut rhinestone, sandblast or another thick material. You can select from 2 to 5 
pass 
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6HQG�WR�ILOH. 
Create a cutting file. 

$GYDQFH. 
Move Vinyl forward after cutting. 
 
6HOHFWHG�REMHFW 
Cut a specific object in your project. You need to select your 
 job before to select this function. 
 
1RWH: When importing a drawing coming from software, the resolution may readjust to obtain better results 
while cutting. The default resolution is 5. 
 
6WDUW  
This function will send your job to the plotter. 
 
6WRS�FXWWLQJ�
This function will deactivate the message sent to the plotter. 
 
1RWH: Stop cutting, depending on your plotter or printer’s capability to store information, some time may be 
needed to process information. If you want the plotter start immediately,  
�
2SWLRQV�Select options from Cutting Control Panel: 
 

 
 
:HHG�YDOXH��Weeding border around�������8VH�VSRROHU��use of the computer’s memory buffer. 
&XUYH�UHVROXWLRQ: Smooth curve quality   6RUW�REMHFW��Sort drawing before to sending it to the plotter. 
3DQHO�RYHUODS��Space between panels�����&XW�OLQH�SDQHO��&ut line between panels (101, 201  etc.)�
.QLIH�RIIVHW��Blade compensate               6DYH�PDWHULDO��Move your drawing to X & Y zero automatically. 
2YHUFXW��Extended cut over����������������������6WDUW�SRLQW�RULHQWDWLRQ��Force blade to cut to right way�
�
You can also select )HHGLQJ�PDWHULDO and (QJUDYLQJ options from this screen.�
�
1RWH���
After choosing an option, you must exit from the Cutting Control panel in order to activate the selected 
function.  
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  &XWWLQJ�&RQWURO�3DQHO��&XW�E\�SDQHOV�
�

�
�

,I�WKH�HQWLUH�SDQHO�ILWV�ZLWKLQ�SDQHO������SORWWLQJ�ZLOO�VWDUW�LPPHGLDWHO\���3UHVV�6WDUW��
�
1RWH� 
The only time you will be asked about panels is when the sign layout is larger than the normal panel limits 
originally set in the�0DWHULDO option, which is the largest size that can be plotted at  one time. When the sign 
layout is smaller than the panel limit, you don’t have to deal with multiple panels and can start cutting  
simply by pressing 6WDUW.  

 
Panels are numbered under Panels, sequentially in horizontal series, (101, 201,301 etc.), from the bottom 
to the top of the sign layout. This value represents the maximum cutting width (vinyl) setting on the 
plotter. This value must be entered  by the user. 

 
 

Depending on the type of plotter, you may first choose to output vertically (101,102 etc). After the first series 
of panels have been plotted (101, etc), the next level of panels (201, 301, etc) can then be sent to be 
plotted. If you select the $GYDQFH option, you can select the entire series of panels before starting the 
plotting because the plotter will advance the material instead of returning to the starting point once a panel is 
done. 
 
If the sign exceeds two panels on the X (horizontal) Axis, it is advisable to verify the vinyl feed on your 
plotter. Some Cutters may require that you advance the material manually, while others (and using the 
Advance option) will advance the material so that another panel can be cut right after the last one.  
Sprocket type cutters need not worry about vinyl feed. 
�

When a sign extends into two or more panels (101,201, 301), it is sometimes convenient for the plotted 
panels to overlap slightly to make it easier to join them when the final sign is assembled. To overlap the Y 
axis (horizontal), go to 2SWLRQV� choose 3DQHO�2YHUODS and enter the desired value (ex: 0.25 inches ) or you 
can plot the panel 101 first, then with the help of the 4 keyboard arrows, move your drawing up�to overlap�the�
join,�then you can cut panel 201.�

�
6HQG�DQ�(PDLO��

�
This function allows you send the current job via email. This function is only available if Microsoft 
Exchange is installed. See Windows documentation for further information. 
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(GLW�PHQX 
 

 
'XSOLFDWH��

�
Make a copy of selected element appear over the original. 

 
.H\ERDUG����ALT+D  
�
(GLW menu, 'XSOLFDWH. 
�
 This function will allow you to immediately make a duplicate copy of an object appear over the original one, 
without having to use the clipboard to paste.  
�
3URFHGXUH���
Select, using the selection tool (or selection window with numerous elements), the element(s) you wish to 
duplicate.  From (GLW menu, select 'XSOLFDWH��then click on your object(s) and move to the desired location.   
The original object(s) will remain behind. 

+LQW��You can also use the shortcut key, $/7�'�
�
&RS\�SURSHUWLHV� 

 
This option allows you to copy the properties of the desired drawing to a selected one. 
 

 

User can copy an element's pen, brush or text properties. 
 
Select the drawing that you want to add the new properties to. From the Edit menu choose Copy properties. 
The program will show this same screen. Select the desired option and press Accept. 

 
1RWH: Text properties can only be copied to another text. 
�

�
0XOWLSO\����

�
���0DNH�PXOWLSOH�FRSLHV�RI�VHOHFWLRQ��

�

� ���
 
����������������������������
�

 
 

  

�
0RXVH���Right button 
 
From the (GLW menu, click on 0XOWLSO\.�
 
This option will enable you to create several copies of a 
selected element, and will let you determine their spacing. 
 
3URFHGXUH��

�
1- Select the desired element. 
 
2- From the (GLW menu, click on 0XOWLSO\. 
 
 3- In the Multiply window, insert the 1XPEHU�RI�FRSLHV to 
be made and the required spacing between them, and  
select the desired $UURZ�GLUHFWLRQ  
 
4- Click 2. to multiply: 
 

 
 
You can also make copies of your copies 
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��

�

5DGLXV�FRS\

 Tool to copy circular elements. Select the item or items previously. 
�
Keyboard:�$OW���5 

�

�
0RYH�WR�D�SRVLWLRQ

�

�

0RYH�FHQWHU�WR�D�SRVLWLRQ
�

�

�
*UDSKLF���&LUFXODU�

 Creates circular graphics with values and caption: 
 

  

1.-Enter a value in the box, and press $GG 

2- Repeat 6WHS��. 

�������������
�������������3URFHGXUH�� 

3-If you want the values to be displayed, click on ,QFOXGH�YDOXHV. 
4-If ,QFOXGH�YDOXHV is selected, you must choose either numerical or �, or both.  
5-If you want to include a caption, click on ,QFOXGH�FDSWLRQ��To associate a caption to its value, click on the 
value   and write your caption in the appropriate zone. 
6-You can also choose to add a frame to you circular graphic.  
7-Click on $FFHSW��when it’s done. 

Procedure: 
-Define  the length and radius of the angle measurement. 
-When Satisfied, press the ENTER key. 
-Repeat  the operation for multiple copies. 
 
Note: If you double click on the vertex of the angle the 
radius of the window open, type a value for the radius. If 
you double click the point at the upper end of the adjacent 
side, the angle window open , type a value for the angle. 

Change the position of a design by giving the value X and Y in 
the dialog box. This value is taken from the left corner of the 
design. 
Confirm with $FFHSW�or &DQFHO� 

Change the position of a design by giving the value X 
and Y in the dialog box. This value is taken from the 
design center. 
 
Confirm with $FFHSW or &DQFHO� 
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To eliminate a value, click  'HO. The value and its caption will be erased. 

 

��
�
��
3URGXFWLRQ��1XPEHUV

 
This function allows you to create a series of numbers beginning with a specific number up to another given 
number. This function allows you to add in front of these numbers and/or after them a series of characters  
(letters and/or numbers). 

 
 

&XVWRPHU

Safeguarding of customer details and cost estimates for current work. 

 

From the (GLW�PHQX, click &XVWRPHU. This option allows you to produce or save a record of the customer's 
contact information, the date of order, the promised delivery date, transportation, terms, comments and the 
estimate for the manufacture of a work. 

Notes: The start date is automatically entered when creating the document. The end date is listed on each 
record.  

1RWH���It is impossible to recuperate deleted values. To modify an 
existing value, click on the value, insert new value. Click on 0RGLI. 
To modify an existing caption, select the value to modify, write the 
new caption. The caption will automatically be modified. To eliminate 
an existing caption, proceed as you would if you were to modify the 
caption, but erase everything instead. To associate a color to a value, 
select the it, then click on the color box situated in right of the value 
entry box.  
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9LHZ�PHQX�
� �
7RROEDUV�

Use this menu to select the bars you want to use. WinPCSIGN opens by default commands, 6WDQGDUG��
7RROV��=RRP��DQG�&OLS$UW. You can also organize your own toolbars by clicking Save as favourite. 
To retrieve the bars affected by the program, click the Default button or Resets. This option allows you to 
place the bars in the original position. 

�
�

6WDQGDUG�EDU�
�
Display or hide the Standard  bar�

 
 

  
   

�

�

�

7RRO�%DU��

 Display or hide the Tool bar�

 

 
 
  

Toolbar by default: 
 
���6WDQGDUG�
���7RROV�
���6HOHFWLRQ��
���&OLSDUW��
�
'HIDXOW��Displays default toolbars on the screen 
5HVHW� reset your selection�
�
6DYH�P\�WRROEDU�
You can create your own layout, 

1HZ�document ( control +N ) 
2SHQ�a document   (Ctrl + O) 
6DYH�DV a document (Ctrl + S) 
&XW�� (Ctrl + X) 
&RS\ (Ctrl + C) 
3DVWH (Control + V) 

3ULQW 
Open &XWWLQJ�control Panel ( F10) 
 5HGUDZ�. Refresh your working screen ( F5) 
 )RQWV. Open the windows fonts. 
 8QGR�  Recuperate delete job (control + Z) 
 5HGR. Redo the last action(s) (control +R) 

 

6HOHFW element  
0DQLSXODWH elements   
Write 7H[W� 
Draw VHJPHQW� 
Draw $UF�IURP�D�SDWK  
Draw )UHH�KDQG. 
Draw 2YDO�RU�FLUFOH. 
Draw 5HFWDQJOH�RU�VTXDUHV. 
0HUJH�to image. 

Image &RQWRXU�WR�FXW �
Open -XVWLILFDWLRQ�EDU (left, right, top or bottom). 
Open 'LPHQVLRQ�OLQH windows. 
 =RRP� Closer to your selection 
(UDVH� 
Open %UXVK�color. 
Open &RORU�SDOHWWH 
3HQ�%UXVK: Open the Pen/brush configuration 
&DOFXODWRU� Opens a calculator 
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�
�

�0DQLSXODWLRQ�EDU�
�
Display or hide the Manipulation bar. 
 

�
�
�
�
�
�
�
�
�
�
�
�

�&XW�VWUDLJKW�OLQH��
 This function will let you cut along straight lines. 

3URFHGXUH��
 
1-Click and hold at the location where the line is to begin. 
2-Move mouse along the desired line 
3- Release when done.  
 
All objects situated under the line will be cut along that line. 
 

                     
 
,I�\RX�ZDQW�WR�VWULSH�D�WH[W��\RX�PXVW�WR�FRQYHUW�LW�WR�SDWK�EHIRUH�\RX�DSSO\�WKLV�RSWLRQ. 

�
1RWH��Holding the 6+,)7�key down during the operation will enable you to cut a straight horizontal or vertical 
line across your object, dividing it in two. 

 

 5RXQG�&RUQHU. 
�
8VH�WKLV�IXQFWLRQ�WR�URXQG�XS�DQ�LPDJH
V�FRUQHU��
�
3URFHGXUH�  
 Select this option in the Manipulating bar. WinPCSIGN will open Radius screen, enter the desired radius 
value. Hold the left mouse button, and slide to create a window around the desired element. 2U�click the 
corner you want to round. 
�

�

�
Hint: If you enter a negative value, you get a round corner into the interior 

 

�

�
� �

0RYH�point�
$GG�point�
&XW�path�
&XW�XVLQJ�VHJPHQW�
6XSHU�Weeding�
6WHQFLO�Bridge�
6QDS�point�
8QVQDS�SRLQW�

Change Vertical���+RUL]RQWDO 
Replace�E\�D�VHJPHQW�
Replace E\�DQ�DUF�
5RXQG�corners 
3UHFLVLRQ�tool 
&RQVWUXFWLRQ�points 
*R�WR XQVQDS�point 
Insert PLGGOH�SRLQW 

�   
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�
�
�

��7H[W�EDU�
 
Display or hide the Text bar 
 

.�
�
�
 

�
�
�
�
�

�([SRQHQW�IRUPDW��
 

With this function you will be able to write in exponent formats. 
 
Write the first portion of the number, then, for decimals, select the ([SRQHQW�IRUPDWV option in the Text bar. 
The cursor will have been modified to write exponent. 

�
�

�6HJPHQW�EDU�
�
Display or hide the Segment bar. 
 

�
 
 
 
 
�
�

�$UF�EDU�
�
Display or hide the Arc bar. 
�

�
�
�
�
�
�
� �

Draw 6HJPHQW�IURP�SDWK 
'UDZ�a segment 
$GG�SRLQW and move 

��

Replace E\�VHJPHQW 
&KDQJH�vertical/Horizontal 
Add PLGGOH�SRLQW 

$UF�IURP path 
3 point DUF 
Replace FXUYH�E\�DUF 

%UHDN arc 
Draw 6SLUDO 

:ULWH�Text 
Text�HGLWLRQ 
)RQW�menu 
Text VSHFLILFDWLRQ� 
Text VSDFLQJ 
Change WH[W�VSDFLQJ 
([SRQHQW�

6XEVFULSW�
,WDOLF�
8QGHUOLQH�
)LW�WH[W to path 
)RQW�VHDUFK�
9HUWLFDO�writing 
6WDQGDUG writing 
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�

�&XUYH�EDU�
�
Display or hide the Arc bar. 
 

�
�

�&LUFOH�EDU�

Display or hide the Circle bar. 
�

�
�
�
�
�
�
�
�
�
�

� �3RO\JRQ�EDU�
�
Display or hide the Polygon bar. 
 

 
 
 
 
 
 
 
 
 
 

�(UDVH�EDU�
 
Display or hide the Erase bar. 
 

�
�
�
�

&RORU�EDU�
�
Display or hide the Erase bar�
�

�
�
�

� �

Draw FXUYH�%H]LHU 
Draw curve %H]LHU�IURP�SDWK 
6QDS�WZR points 

8QVQDp two points 
)UHHKDQG�Vcreen 

Draw 2YDO 
Draw &LUFOH 
Draw circle IURP���SRLQW 
Convert object WR�&LUFOH 
Make�FRQFHQWULF�&LUFOHV 

Move circle IURP�FHQWHU 
Convert FLUFOH�WR�VTXDUH 
Convert FLUFOH�WR�VWDUW� 
Convert DOO�REMHFWV�WR�FLUFOH 
 

'UDZ�5HFWDQJOH�or square 
Draw &LUFOH 
Draw VWDUW or polygon 
'UDZ�$UURZ�
 

Enter desired polygon side value: 
 

 

(UDVH�DQ element 
(UDVH�DQG�FORVH path 
Erase�E\�FRORU 
Erase DOO�SDWK�VXUIDFHV 

Fill FRORU 
Open JUDGLHQW�screen 
Remove ILOOHG�Folor 
)LOO�select element 
6RUW�  Smart  filling. 
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�

��-XVWLILFDWLRQ�EDU��
�
Display or hide the Align tool bar.  
 
Click on�-XVWLILFDWLRQ�EDU�from the 9LHZ�menu. The Align bar will be found on the right of the screen. It 
offers the following tools:  
 

 
  

 
 
 
 
 
 
 
�

$OLJQ�WR�OLQH�JXLGHV��
This function will align objects according to line guides selected by user.  Line-guide selection is done by 
clicking it with the left button: 

6KRUWFXW���  
 
3URFHGXUH���
1 Select desired elements. 
2 Select�$OLJQ�WR�OLQH�JXLGHV from the Align bar.  

�

�=RRP�EDU�

Display or hide the Zoom tool bar.  

�

�

�

�

�

�

)RQW�PDNHU�EDU�

Display or hide the Font maker. (watch a video) 

�

Align OHIW�   
Align�ULJKW    
&HQWHU 
9HUWLFDl justification             
Align ULJKW�RQ�SDJH             
&HQWHU��KRUL]RQWDOO\���YHUWLFDOO\  
Align 8S�� 
Align 'RZQ���                                           

&HQWHU Page           
$OLJQ�WR�OLQH guide* 
$OLJQ�OHIW�on page 
$OLJQ�ULJKW on page 
$OLJQ�FHQWHU�on page       
Space MXVWLILFDWLRQ  
'LVWULEXWH�VSDFH�between objects horizontally 
Distribute VSDFH�EHWZHHQ�REMHFWV vertically 

Zoom ZLQGRZ 
Zoom SUHYLHZ 
Zoom VHOHFWLRQ 
Zoom DOO 
Zoom SDJH 
Zoom VPDOO 

See :LUH�IUDPH  
&RQVWUXFWLRQ�SRLQWV�on/off 
Get FRORU�IURP�LPDJH to palette 
5KLQHVWRQH�selection screen 
7VKLUW�selection screen 
&DSWXUH�UHJLRQ�of an image 

5HSODFH�OHWWHU to a fonts 
Set letter WR�;�zero position 
Set letter�WR�;�< zero position 
Set a letter tR�< zero position 
Change IRQW�QDPH 
Change the NHUQLQJ 
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�

��,PDJH�EDU.  
  
Display or hide the image bar. 

From the 9LHZ menu, 7RROEDUV submenu, click on�,PDJH�EDU. The image bar will appear on the right of the 
screen and will offer the following tools:  

 
 

  
  
 
 
 
 
 
�

�'LPHQVLRQ�OLQH�EDU�

Display or hide the dimension line bar.�

�

�

0DJLF�UXOHU�EDU���:DWFK�D�9LGHR��

Display or hide the Magic ruler bar.�

�

�

&OLSDUW�EDU�

Display or hide the Clipart bar. (Open on right side of the screen)�

�

�

�

� �

0HUJH�select                     
Automatic YHFWRUL]DWLRQ�� 
3KRWR�FXW                          
7RXFK�8S��                                            
6RIW�WRXFK�����������������������������������������������
Rectangular UHJLRQ����             
2YDO�region                                         
 

3HUVRQDOL]HG�region 
5HPRYH Region 
0LUURU�,mage 
)OLS�image      
,WDOLF����
5RWDWLRQ���
3HUVSHFWLYH�
                 

9HUWLFDO�dimensional line 
+RUL]RQWDO�dimensional line 
'LDJRQDO�dimensional line 
$QJXODU dimensional line 
Setup Unit & 3UHFLVLRQ 
6HOHFW�IRQW�

$GG�0DJLF ruler to picture 
5HPRYH�0DJLF�ruler from picture 
Using GLPHQVLRQDO�OLQH 
Object PHDVXUHPHQW 
2SHQ�UXOHU�
 
 

2SHQ�/RJR�6LJQ0$;�
�
�
*R�WR�ORJR�ZHE�VLWH�
�
�
'UDZ�XVLQJ�)UHH+DQG�
�
�
:DWFK�WUDLQLQJ�YLGHR�
�
�
2SHQ�YHFWRUL]DWLRQ�VFUHHQ�
�
�
2SHQ�:<6L:<*�VFUHHQ�
�
�
2SHQ�RXU�ZHE�VLWH�
�
�
2SHQ�&XWWLQJ�&RQWURO�SDQHO�
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�

5HJLVWHU�

Display or hide the Register bar 

�

 

 This command allows you to enable or disable printing for a selected item. The print permission allows 
or refuses to print an item. When the print permission is denied, a red X will appear in the bottom of left 
corner of the element. 

�

�&RORU�SDOHWWH�
�

Click on the icon to open the &RORU�SDOHWWH�

�

�0DUNHUV�
 

This function will enable you to display markers. An active marker is in red, non-active markers are in blue. 
  

Add PDUNHU 
5HPRYH marker 
Move element to the�PDUNHG 
3ULQW�SHUPLVVLRQ��
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'UDZ�PHQX���
�
�
6HJPHQW��

�
�
'UDZ�VHJPHQW  
 
Draw individual segments 
�

�
�
�
�
6HJPHQW�IURP�SDWK�
�
Design joint segments.�
�

�
�
�
�
�
�
��SRLQW�VHJPHQW�)��
�
This option is useful to replace a path composed of several straight lines to a single segment. 
 

  
 
 
 
%UHDN�VHJPHQW�
�
This function allows you to divide a segment into two or more. 

 
�
�
9HUWLFDO�+RUL]RQWDO�
�
�

�
�
Procedure: Click on a line and it will take a vertical or horizontal position automatically. 
�

� �

Procedure: Select a segment from draw menu then place the cursor where 
you want to start to draw the segment. Right-click and hold the button, 
scroll to the desired size. With this option you can draw segments without 
joining them. 

This feature is ideal for digitizing a bitmap. Since this type of joint allows the first 
segment point of the segment in the last point of the drawing object. 
 
Procedure: Once the first segment was drawn to the cursor to where you want to 
end the new segment, and press the left mouse button. The new segment will 
automatically connect to the point. You can repeat this process to create the 
desired shape. 

Procedure: Click the left mouse button at the beginning of the line to be 
replaced, press the button, a red line shows the trace ragged path. Release 
the button to complete. 

Procedure: Place the mouse cursor to where you want to break the segment. Then 
press the left mouse button, hold and drag the item to the place that suits you. This 
option is useful for increasing the points in the design. 

The vertical / horizontal option put a segment in an upright position (vertical or 
horizontal) with one click this is useful for correcting the lines of a drawing or a 
vector text. 
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�
�
$UF��

�
 
'UDZ�DUF�
�
By enabling the arc in the menu, you can start drawing with arcs. 
�

�
�
�
$UF�IURP�SDWK�
�
Draw connected arcs.  
 
This function is ideal for copy an image drawing around it  because this type of arc allow you to connect  the 
first point of the arc to the final point of the drawing object. 
 
Procedure: After the first arc was created, move the mouse to mark the center of the second arc and move 
to where you want to end, then release the button.  The new arc will automatically connect to the point. You 
can repeat this process until you get the desired shape. 
�
�
�
��SRLQWV�DUF��)���
�
This option allows you to replace a curve composed of small lines or arcs by a single arc. 
�

�
�
�
%UHDN�DUF�
�
This option allows you to break an arc in two or more 
�

�
�
 
�
)UHHKDQG�

�

)UHHKDQG�'UDZLQJ�

�

 

 

 You can also select the IUHHKDQG�VFUHHQ. This function allows you to draw anything. This tool works 
great with graphic tablet like Wacom tablet. 

Procedure: 

 Select )UHH�+DQG icon from right tool bar. Then select the  your line size (Pen) and the 
color that you want and start drawing your shape on screen. 

Procedure: Click the first point to start. Move the mouse to mark the center 
of the arc, hold the button and drag to create the arc. Release the button. 

Procedure: Place the first point and press the left mouse button and 
move the mouse to the center and hold the button, scroll to the third 
point, forming the curve and release the button to complete. The 
program will take a few seconds and then replace the curve for the new 
arc 

Select the function, then move the cursor to the arc you want to break 
and click  the left mouse button. 

This option allows you to draw closed curves Bezier using the mouse like a 
real pencil. 
 
Procedure: Select the function and start drawing your shape. WinPCSIGN 
automatically close the form to end 
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If you want to create a hole into a black zone, simply use the white color. It's really all about logic. The black 
shape you see is what is going to be cut. 
You can use the eraser tool to erase a line you've created.  Take some times to test the eraser tool, it 
doesn't work the same way the pencil does.  Press the OK button and you are ready to go: 

 

The result depends on your calligraphy 

)UHHKDQG�IURP�SDWK�
�

�
�
-RLQW�WZR�SRLQWV�
�
This option lets you connect two ends of a segment or arc to create a single path. 
 
Procedure: Select the function, then with the help of the mouse, draw a rectangle around the opened points . 
Use the same option to continue to join other disconnected points. 
 
To see the open points in your design, select the See opened path function from Shape menu. This function 
displays the no connected points with a circle.  
 
2SHQ�SDWK�
�
Separate two connected points. 
Procedure: Select the function, then with the help of the mouse, draw a rectangle around the points that you 
want to separate. Use the same option to continue to open the other points connected. 
 
 
5HFWDQJOH�
&UHDWLQJ�UHFWDQJOH 
� �
�
� �

This option allows you to draw Bezier curves and connected to an object drawn 
on the screen. This is convenient to create freehand drawings. 
 
Procedure: Select the function and start drawing your shape. WinPCSIGN, 
automatically connect to the last object 

By enabling this option, you can draw squares and rectangles. 
 
Select the function, then hold the left mouse button and start drawing your 
rectangle or square and release the button. Use this function 7UDQVIRUP�if you 
want to change the dimension 
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�
�
6WDU�DQG�3RO\JRQ�

�
'UDZ�SRO\JRQV�DQG�VWDUV�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
2YDO�

�
'UDZ�FLUFOHV�DQG�HOOLSVH��
 
Select 2YDO�from the Draw menu, then hold the left mouse button and start drawing your oval or circle.  
You can draw in the position and the desired height. 
�
�
'UDZ�DQ�DUURZ� 

�
7KLV�IXQFWLRQ�ZLOO�HQDEOH�\RX�WR�GUDZ�DUURZV� 
 

�

6KRUWFXW� �� �
 

 
Select the function and press the left mouse button and drag the mouse in the desired direction and release 
the button to finish. To change the shape of the arrow, just select a square and drag the mouse in the 
desired direction. Press enter to finish  You can modify them to suit your needs using the handles. 

 
3URFHGXUH��Draw your desired arrow where you wish and press on (17(5 to accept them. 
�
�
'RXEOH�2JHH�
7KLV�WRRO�ZDV�GHYHORSHG�WR�FUHDWH�FHPHWHU\�Headstones. 
�
7KLV�WHUP�LV�XVHG�IRU�D�PROGLQJ�ZLWK�DQ�RJHH�VKDSHG�SURILOH��FRQVLVWLQJ��JRLQJ�IURP�ORZ�WR�KLJK��

Procedure:  Select 2JHH function from 'UDZ�PHQX. WinPCSIGN will open this screen: 

 

Enter the :LGWK and +HLJKW value, then enter the desired +� molding and 7DSHU  
value. Press $'' . 

From the Draw menu select Star, on screen, number of spikes appears.  
Enter the sides and click OK 
 
Depending on the number of sides entered, you can draw stars triangles, 
hexagons etc. 
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Example: 

 

You can also select 7H[WXUH from Color Palette and apply to your stone. 

 

 

6HOHFW�DOVR�0RQXPHQW�)RQW��

)RQW 

 

� �
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'LVWRUWLRQ� 

 

                
 5HJLVWUDWLRQ�PDUN�

7KLV�WRRO�ZLOO�HQDEOH�\RX�WR�DGG�5HJLVWUDWLRQ�PDUNV�WR�\RXU�FXWWLQJ�SURMHFW�� 
 
Procedure to activate the 5HJLVWUDWLRQ�PDUN� tool for the active document  

               
3URFHGXUH���
1- From the 'UDZ�menu, select 5HJLVWUDWLRQ�PDUN to activate tool. 

2- On your work page, click at the location where you wish to insert your registration mark.  
 

When the 5HJLVWUDWLRQ�PDUN tool has been activated, you can select the type of mark you want to use. To 
make your selection, you must click the right mouse button.  The Registration mark selection window will 
appear. 

 

    
 

Available formats are: Circle, square, hexagon, star and cross.  
The selection of the format is made by clicking on the desired image in the Registration mark selection 
window. Click on $FFHSW when your selection is made. 
 
 
�
1RWH���
When using the Registration mark, it is always possible to change the format of the next Registration marks. 
Simply press the TAB key to switch to the next type of Registration marks. It is possible to add Registration 
marks around the objects in selection by double clicking the left mouse button, or by pressing the 6 key. 5 
Registration marks will appear, one at the center of the group of selected elements 

� �
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�

3UHFLVLRQ�WRRO. 
 

6KRUWFXW� �� �
 
This method will enable you to draw with great precision arcs, rectangles, segments, circles. Diamond and 
points 
 

 

�
'UDZ�VHJPHQWV� 
 
This precision tool will let you determine the degree of precision used to create segments in a drawing. Enter 
a value for X and Y at the start of your segment, as well as  for the end of the segment. Select the number of 
divisions and the space between them. When done, press 2 
�
'UDZ�UHFWDQJOH� 

Start your rectangle by attributing the lower corner X and Y values. Attribute your rectangle a height and 
length. Click $GG and 2.. 
�
'UDZ�SRLQWV�DUF���
 
 1-Attribute an X/Y for the first point. 

 2-Attribute an X/Y for the second  

 3-Attribute an X/Y for the third point. 

 

&LUFOH��
Create a circle with the center position and the size of its radius. It has possibility of a circle only with bows 

that can be spaced between them. The Close option means that the ends of the arcs are connected by a 

segment with the center. 

'LDPRQG��
This option allows you to create diamonds preserving the spaces between them. Enter the height, the width 

of the value of the DX and space, then the number of horizontal and vertical copies. Tap Add to create. 

Spaces will always equal. 

 

3RLQW��
This option creates points that can be used for engravings. Among the X, Y, choose the depth of the first 

point and press Add. Continue with the second point and press Add. The points have the values that have 

been added to the working screen. 
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6XSHU�:HHG��

�
)XQFWLRQ�XVHG�WR�IDFLOLWDWH�WKH�UHPRYDO��ZHHGLQJ��RI�YLQ\O�DIWHU�D�FXWWLQJ�SURMHFW��
�

6KRUWFXW� �� �
�
�
This enables you to add cutting lines to your project. By dividing your work with a number of these lines (that 
do not cut your work, only the outside vinyl), you will be able to remove the unwanted vinyl portions with 
great ease. 
 

�
�

� �
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�

7H[W�PHQX� 
 
'LFWLRQDU\

 
7KLV�RSWLRQ�DOORZV�\RX�FKHFNLQJ�WKH�VSHOOLQJ�RI�\RXU�WH[W��

 )RQW
�

From 7H[W menu, click on )RQW. WinPCSIGN will open Font menu. 
 

6KRUWFXW�   
.H\ERDUG� Ctrl + F  
 

3URFHGXUH��

Select �icon, click on the screen where you want to star to write your text, then select  your text and 

click  to open Font menu: 
 

  

From the font menu you will be able to select different font characters selecting &XWWLQJ or 7UXH7\SH���You 
can also get more style from the CD-ROM Font collection by selecting the option &DWDORJXH�or the option�
6HDUFK� if you copied the fonts to your computer.   
 
If you want to see all the character, click�&DSLWDO��/RZHU�&DVH�or�1XPEHU�  
You can add new�7UXH�7\SH font to your computer. To learn how you can DGG�QHZ�7UXH�7\SH font  
watch this movie . If you double click over a selected font, you can change the name.   
   
You can also, select the desired style italic, bold, bold italic, regular, underline or strike. Press 'HIDXOW�button 
if you want to keep same font style for future jobs.  Finally enter the +HLJKW�and click 2., to exit and star to 
write your text.  
 
If you already know which font you are looking for, type the first letter, and locate it with the arrows from 
keyboard   
   
1RWH��:H�UHFRPPHQG�HQWHULQJ�WKH�ILQDO�KHLJKW�RI�\RXU�OHWWHU�LQ�WKH�)RQW�VFUHHQ�DQG�QRW�IURP�
7UDQVIRUPDWLRQ�EDU  
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:ULWH�7H[W� 

7KLV�IXQFWLRQ�LV�XVHG�WR�ZULWH�WH[W� 

6KRUWFXW��    
0RXVH�� Right click button.  

3URFHGXUH����
From 7H[W menu, select :ULWH�WH[W�or double click on�7�icon from Tool menu.                   
               
�
With the help of the mouse place the cursor at the desired location on the screen. Click the left mouse 
button and start writing your text  

2SWLRQDO� If you wish to modify the text, select the word  that needs to be changed then from 
 7RROV menu select, 7UDQVIRUP submenu. This bar offers all the tools necessary to modify your text. 

Note: The height of your text must be set on Fonts (F) menu 

�
7H[W�(GLWLRQ� 

 

6KRUWFXW��   
0RXVH�� Text mode + Right button  
.H\ERDUG�� Ctrl + T  

Double click with the mouse on the screen to open. The Text edition window contains the basic edition tools. 

  
 
8QLFRGH�IXQFWLRQ��
�
$UDELF�)RQWV 

Auto Vectorization mode for Arabic Fonts This function allows you copy and paste Arabic characters and 
text.  
Procedure: �&RS\ your Arabic text from Word, Web etc and SDVWH�it to WinPCSIGN to the Text Editor 
screen.  (Press�&UWO���7 to open the editor) Then select $ULDO from )RQW menu and press Ok. 

&KLQHVH��5XVVLDQ�DQG�RWKHU� 
 

This function allows you FRS\ and SDVWH Chinese, Russian, etc characters or symbols   from :RUG��
([FHO etc to WinPCSIGN keeping the same property. Then edit them and send to the cutter 

Procedure Copy from your software the desired text, then go to WinPCSIGN and Paste your characters or 
symbols to the Working Screen: 
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)LW�WH[W�WR�SDWK�  
 

7R�ZULWH�WH[W�RQ�D�JLYHQ�SDWK�� 
   

  
   
 1RWH�  If you have more than one text to fit to a single path, apply the )LW�WR�3DWK function after selecting 
ONLY one text along with the path. Once satisfied with the result, temporarily move the first text out of 
range. Now apply the )LW�WR�SDWK function once more, this time having selected the second text along with 
the path. Once satisfied with the result, bring back the first text and position it back along the path. Now both 
of your texts will fit the selected path. 

 

)LW�WH[W�WR�FLUFOH�  
 

�7R�ZULWH�WH[W�RQ�D�FLUFOH�  
�
0RXVH� Text mode + right button.  
   

  
 
1RWH� If you have more than one text to fit to a single circle, apply the )LW�WR�FLUFOH function after selecting 
ONLY one text along with the circle. Once satisfied with the result, temporarily move the first text out of 
range. Now apply the )LW�WR�FLUFOH function once more, this time having selected the second text along with 
the circle. Once satisfied with the result, bring back the first text and position it back around or inside the 
circle. Now both of your texts will fit the selected circle. 

 

From text menu, click Fit text to Path 
�
3URFHGXUH�� 

x Write a text and draw a curve. 
x Select both the text and the curve. 
x From the 7H[W menu, click on )LW�WH[W�WR�SDWK� 
x Select your position, direction, spacing between characters etc…. 
x Press Erase Path if you want to delete your base 
x Press Apply 

        <RXU�WH[W�VHOHFWLRQ�ZLOO�FORVHO\�IROORZ�WKH�FXUYH���
�

�

 

From the 7H[W menu, click on )LW�WH[W�WR�FLUFOH.  
�

3URFHGXUH�� 

x Draw a circle.  ( from Draw menu) 
x Select the circle and a text. (both) 
x From the 7H[W menu, click on )LW�WH[W�WR�

FLUFOH�IXQFWLRQ. 
x In the Circle window select the desired 

radius. 
x Click on the position of your choice and 2.. 
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1XPEHU�IRUPDW�
�

7KLV�IXQFWLRQ�LV�XVHG�WR�ZULWH�SULFH�IRUPDW�
�

�
�
Select the function from 7H[W�PHQX, then write your price and select the desired format. Press 2. to create 
�
�
0RYH�WR�

�
7KLV�IXQFWLRQ�DOORZ�\RX�WR�PRYH�\RXU�WH[W�WR�D�QHZ�SRVLWLRQ�
�

�
�
Select the text to move, then from 7H[W�PHQX choose 0RYH�WH[W screen. Enter the desired value 
; and <�and press 2N 
�
&RS\�WH[W�

�
7KLV�IXQFWLRQ�DOORZ�\RX�WR�FRS\�\RXU�VHOHFWHG�WH[W�
�
�
0LUURU�WH[W�

�
7KLV�RSWLRQ�LV�XVHG�WR�UHIOHFW�\RXU�WH[W�
�

�
�
Select your text, and then from 7H[W�PHQX�choose�0LUURU�7H[W function. WinPCSIGN will turn 
your text automatically.  You can use this function for cutting Tshirt design and signs that you 
want stick inside a windows but reading from outside   
�
�
&RQYHUW�WH[W�WR�SDWK�    

 
7KLV�IHDWXUH�LV�XVHG�WR�FRQYHUW�DQ\�WH[W�WR�SDWK�� 
�
0RXVH� Text mode + right button. 
Select your text, then from the 7H[W PHQX, click on &RQYHUW�WH[W�WR�SDWK. WinPCSIGN will convert 
automatically your text to path.  Attention, all path of the text will be independent   
 
If you want edit or modify your text, we recommend to activate the construction points.  
 
  

 
7KLV�IHDWXUH�LV�XVHG�WR�DQQXO�DOO�WUDQVIRUPDWLRQV�GRQH�WR�D�WH[W���
   
0RXVH� Text mode + Right button.  
From the 7H[W menu, click on &OHDU�WH[W�WUDQVIRUPDWLRQ. You can annul transformations done to a text or 
element.   
+LQW�  It is preferable to click the red ; on top of the main window to annul recent operations. 
It permits the cancellation of several modifications. 
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5RWDWH�WH[W�

�
This option allow you to turn your text 
 

 
 
Select your text, and then from 7H[W�PHQX�choose�5RWDWH�7H[W function. WinPCSIGN will show 
5RWDWLRQ screen. Enter the desired Angle and Centre axe value and press 2. 
 
 
 
7H[W�VSHFLILFDWLRQ�

 
�������������7KLV�IXQFWLRQ�DOORZV�\RX�FKHFN�WKH�VSHFLILFDWLRQV�RI�WKH�WH[W� 

6KRUWFXW�  
Mouse:  Mode Text Right button. 
 
Procedure: Select the last written line of text, and then, click this function from 7H[W�PHQX� WinPCSIGN will 
open 7H[W�VSHFLILFDWLRQ screen  
�
�

�
�
<RX�ZLOO�ILQG�WKH�IROORZLQJ�VSHFLILFDWLRQV��
�
�
 
 
  
 
 

  

)RQW�W\SH�
�7\SH�RI�IRQW��
��1DPH�RI�WKH�IRQW�
��,WDOLF�YDOXH�URWDWLRQ�
��6SDFH��
���
�/LQH�VSDFLQJ����

��
 

�0HDVXUH�
���+HLJKW�
���/HQJWK�
�&RQGHQVDWLRQ�DGGHG���
�+RUL]RQWDO�
�9HUWLFDO�
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              %UHDN�WH[W�

�
This option allow you to separate your text in Characters, Word, Lines and Outline 

 

 
 

$OLJQ�WH[W�WR�/HIW��5LJKW�RU�&HQWHU��
 

Use option to align your selected text to a desired position 
 

Select your text, then from text menu chose the desired alignment. WinPCSIGN will automatically align your 
text. 

 
 

)RQW�6HDUFK�
7KLV�RSWLRQ�DOORZV�\RX�WKH�VHDUFK�DQG�LGHQWLILHV�D�IRQW�DQG�ILQG�WKH�QDPH���
�
 Vectorize or design your character.  Then from 7H[W�PHQX select the option )RQW�)LQGHU;�
Select your character with the mouse, then type or write this character and press 6HDUFK button

�
�WinPCSIGN will show you the following screen: 
 

�
 
The 3HUIHFW�0DWFK allows you to extract the character that you need from Font search to the working 
screen. 
 �
<RX�FDQ�SXW�WKH�&'�)RQW�FROOHFWLRQ�DQG�SUHVV�6HOHFW�EXWWRQ�WR�H[WUDFW�WKH�IRQW�IURP�WKH�FG���&OLFN�
RQ�WKH�VFUHHQ�DQG�VWDUW�WR�ZULWH�ZLWK�WKH�QHZ�IRQW�
   

You can use this function to work with letters or a line of text 
individually. You can also separate a welded outline . 
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&UHDWH�IRQW�

8VH�WKLV�IXQFWLRQ�WR�FUHDWH�\RXU�RZQ�IRQWV 

Prepare your alphabet with symbols, then from 7H[W�PHQX, select &UHDWH�)RQW to open the font 
creation bar: 

 

 

To begin your alphabet, move your first letter (A) to XY zero position�����then select  icon. WinPCSIGN 
will open the )RQW�PRGLILFDWLRQ screen. Enter your desire font name�����and write the first characters of the 
alphabet ����WinPCSIGN show also the position number of the character in the alphabet �����Click 2. and 
repeat this operation to the last letter and symbols. 
 
 

�
�
 

 

1RWH��IRU�URXQGHG�DQG�ORZHUFDVH�OHWWHUV�GR�QRW�IRUJHW�PRYH�LW�WR�XQGHU�EDVHOLQH�SRVLWLRQ��6HH�
H[DPSOH��������EHORZ��

�

� �

$GG�RU�UHSODFH�OHWWHU to a fonts 
Set letter WR�;�zero position 
Set letter�WR�;�< zero position 
 

Set a letter tR�< zero position 
Change IRQW�QDPH 
Change the NHUQLQJ 
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9LVXDO�WH[W�VSDFLQJ

Generate space between letters 
 

This option allows you to remove or reduce the spaces between the characters and / or the space between 
lines of text. Select your text, then use the arrows Screen and Interlines to apply spaces: 
 

 

You can also use the mouse to add spaces. If you want to reduce or enlarge the space of a letter, move the 
small square individually.  

To enlarge the spaces between lines, use the down arrow (1). To reduce or enlarge the spaces between the 
letters use the right arrow (2). 

By selecting one or more points in a word, you can move one or letters selected with the arrow keys. 
 

Finally, press the arrow selection, to complete.  
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7RROV�PHQX�
�
�
�
�
6HOHFWLRQ�

�
 
6HOHFW�
 
This option allows you to select objects on the screen�
�

�
�
�
'HVHOHFW�$OO����&75/�'��
�
This option cancels the selections previously made. 
�
6HOHFW�$OO���&75/�$��
�
This function allows you to select all items in one group. This way you can move, change size etc to all 
group and not individually.   To cancel, click outside of the selected design. 
�
,QYHUW�VHOHFWLRQ��)����
�
This option allows you to select objects that are not selected on the screen. This will deselect the original 
selection. 
�
6HOHFW�VLPLODU�%UXVK�FRORU��
 
This option allows you to select all elements of the same brush color (filled) on your screen. 
Select the function, and then with the help of the mouse, click the object that you want to select.   
To cancel, choose 6HOHFW function   
�
6HOHFW�VLPLODU�3HQ�FRORU�
�
This option allows you to select all elements of the same Pen color (no filled) on your screen. 
Select the function, and then with the help of the mouse, click the object that you want to select.   
To cancel, choose 6HOHFW function   
�
6HOHFW�VLPLODU�REMHFW�
�
This option allows you to select all objects that are already selected with the same form. �
�
6HOHFW�/DVVR�
�
With the help of /DVVR� draw a shape around the objects that you want to select. WinPCSIGN will show 
the selected elements with many smalls white square.  
Press one of the keyboard arrows: 8S, 'RZQ, /HIW or 5LJKW if you want to move.  
 
Hint: you need keeping the left mouse button down to draw your shape. 
 

To cancel the function, select  icon. 
 

 
  

Click with the left button mouse on your Design, Text, Image etc. WinPCSIGN will 
show the eight selection nodes. This way, you can enlarge, reduce, move, Condense 
etc. 
Important: 99.9% of the tools won’t work if you do not select your design on the 
screen 
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 �
�
�
5HIUHVK�ZRUN�VSDFH�

�
After editing your designs, the modifications can be let some garbage on your screen. Select 5HIUHVK�
function to clean the screen�
�
You can also press )� from keyboard 
�
(UDVH�

�
Erase items from the screen.  
 
Select the (UDVH�IXQFWLRQ�from 7RROV�PHQX and click on the object that you want erase. You can also 
encircle your selection to erase it. 
 
You can recover the deleted files by selecting 8QGR from the (GLW�PHQX or retrieve pointing on the red ;�
in the command bar. By activating the (UDVH�EDU�from the 9LHZ�PHQX, you can select other erase 
options: 
 

 
 
�
You can use the 'HOHWH�button from the keyboard to delete your selection.�
�
0HDVXUH�

�
This function allows you to measure a distance of an object on the screen. 
 

�
�
�
�
2EMHFW¶V�PHDVXUHPHQWV� 

 
Tool used to measure selected paths, circles and ellipses. 
 
3URFHGXUH���
�
1-Select the elements from which you like to obtain measurements.  
 2 - From the 7RROV�PHQX�select 0HDVXUHPHQWV�RI�REMHFWV. 
 
3- From your measurements window, you can look at the values obtained, export them to Excel (Export 
key), or insert  them in you current work. (Add key). 
�
1RWH� 
You have the possibility of using a specific scale for your data. To do so, you simply have to activate a 
magic ruler (See Activation of Magic Ruler) and use the software’s dimension line mode (See Dimension 
line. 

 
Example of measurements 

 

 
 
 
� �

Erase. 
Erase and Close 
Erase color, 
Erase small objects. 

Select the 0HDVXUH�option; click the 
beginning, keep the left mouse button and 
drag the mouse to measure the object. 
 
 A broken red line shows the area you have 
selected: 

 
The values will be displayed on the measure 
screen. 
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0DJLF�5XOHU���$FWLYDWH���8VH��
 

This option allows you to measure angles, height, length or any distance in your picture. To do so, you need 
to take the photo with the magic ruler accessory on the picture. 

 

 
 

This function will enable you to set and use the Magic Ruler. 
 
The Magic Ruler is activated when you click on an image without associations. 

 

If the following image:  appears on the lower left corner, this means that the Magic Ruler is activated for 
this image. 

 
������������

$FWLYDWLRQ�SURFHGXUH: 
 

1 From the 7RROV menu, 0DJLF�5XOHU submenu, select $FWLYDWLRQ�XVH. 
2 Click on the image (with the Magic Ruler) with the left mouse button, and answer <HV. 
3 Left click on the beginning of the Magic Ruler. 
4 Left click the opposite end of the Magic Ruler. 
 
 
You can hold the left mouse button for the second point to adjust  the position. When done, simply release. 

1. In the Magic Ruler Selection, select the Magic Ruler to use (if it is available in the window). Press on 
%DFN��If you’re magic Ruler is not installed, press on ,QVWDOO and follow the procedure. When done, click on 
%DFN 
 

                             
 

           
0HDVXUH�GLVWDQFHV�LI�WKH�0DJLF�UXOHU�LV�DFWLYDWHG 
�
8VDJH�3URFHGXUH: 

1 From the 7RROV menu, 0DJLF�5XOHU submenu, select $FWLYDWLRQ�8VH 
2 Click with the left mouse button an image with the Magic Ruler activated. This positions the first point.  
3 Click with the left mouse button the second point of the  desired  distance.  
4 Click and hold the left mouse button if you want to precisely adjust  the second point. 
5 The distance value will be displayed in the message bar.  (See arrow bellow) 
 

 
                                                
Note: As long as the button is pressed, the distance will be calculated. See 'LPHQVLRQ�OLQHV for help on the 
subject.  If you have made a mistake, you must deactivate the Magic Ruler and reactivate it again. 

 
1RWH� 
Holding the 6+,)7�key down will enable you to limit your movements to the horizontal and vertical axes. 
�
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�������������0DJLF�5XOHU���'HDFWLYDWH� 

Deactivates the Magic Ruler associated to the selected elements. 
 
1RWH��The image must be selected before selecting this option. 
 
0DJLF�5XOHU���'LPHQVLRQ�OLQH�PRGH� 
 
Once activated, the new lines will use the scale defined by the  magic ruler. 

              
             $FWLYDWLRQ�3URFHGXUH� 

1 Select an image where you have already an activated Magic Ruler. 
2 Go to the 7RROV menu, 0DJLF�5XOHU submenu. 
3 Select the�'LPHQVLRQ�OLQH�PRGH. 
 
For that point onward, all dimension-line measures taken will use that scale. 
 
1RWH��To deactivate 'LPHQVLRQ�OLQH�PRGH. 
 
'HDFWLYDWLRQ�SURFHGXUH��
�
1. Deselect all. 
2. Go to the 7RROV menu, 0DJLF�5XOHU�submenu. 
3. Select 'LPHQVLRQ�/LQH�PRGH. 

 
1RWH���Holding the 6+,)7�key down will enable you to limit your movements to the horizontal and vertical 
axes. 
�������������
6KRZ�WKH�FRGH�FRORU�

�
This function allows you copy a code color then add it to color palette. 
�

�
�
�
7UDQVIRUP�

 
From 7RROV�PHQX, select 7UDQVIRUPHU. 
 

  
 

 

 

Select 6KRZ�WKH�FRGH�FRORU�function from 7RROV�
PHQX, then from Color under cursor screen, select   
5*%�or &0<., move the cursor over the color that 
you want to copy. The code will appear in the en   
&RORU screen.  

 
Use this feature to create your own colors and add to 
the palette. 

In this menu you will find the following options: 3RVLWLRQ��
:LGWK��+HLJKW��&RQGHQVHU��LWDOLF��0LUURU�and the�=�value� 
This bar is displayed each time you select a function. 
 

You can also enable this Transformation bar, by typing the 
first letters of functions. Example: 3�(position), : (width), etc. 

The column on the right lets you insert a value that will be 
added or subtracted to the value entered in the column on 
the left.  
 

Select the desired function, and then enter the value :� + or 
$QJOH���Select�'XSOLFDWH�DQG�$FFRUGLQJ�WR��if you want to 
make copies of your selection.  

 
Select $SSO\ to accept 
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�

+HLJKW�

�

  
 

This menu is opened all the time on the screen. You can also open it pressing a letter +� (height) 
/�(length) 0 (Mirror) and others from the keyboard  

:LGWK�
�

� �

Select the element to modify. From Edit menu, click 
Change height o press + from your keyboard. 
 
In the Transformation window, enter the desired 
value and click Apply. In the column on the right, you 
can insert a value that will be added or subtracted to 
the height (H) 
 
You can select the position of your object according 
the selected point. And also create a duplicate in 
case of Mirror selection.  
 
Very important: when you enter the KHLJKW 
WinPCSIGN will calculate the OHQJWK�automatically  
If you want keep the length or height values, use 
&RQGHQVH function 
 
We recommend to enter the Height of your text, 
directly in )RQW�menu (F) 

Select the element to modify. From Transformation bar 
select :LGWK, enter the desired value�:�and click Apply.  
 
Very important: when you enter the :LGWK, WinPCSIGN 
will calculate the +HLJKW�automatically  
 
If you want keep the length or height values, use 
&RQGHQVH function: 
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5RWDWH�7UDQVIRUP�VXEPHQX�  
 This option allows you to rotate objects and texts 

 
�
,WDOLF�7UDQVIRUP�VXEPHQX��
 
This option allows you to italicize an object and text. 
 

.  

�
5HDO�VFDOH�7UDQVIRUP�VXEPHQX�

�
This option allows you to resize your assembly on a required ratio 
Once the function is selected, enter the value of the ILQDO�ZLGWK�from the rescale dialog box, then press 
2. to apply the final length. 
 

�
�
�
2UWKRJRQDO�URWDWLRQ��7UDQVIRUP�VXEPHQX�

 

6KRUWFXW�� �  �
 

Applies a rotation to bring segment to the nearest 90° You can  
only apply this rotation angle.  The rotation affects the selected elements. If you want to apply a rotation on a 
single element of the selected group, press and hold the 6KLIW key while clicking the desired object. 

 
1RWH���on a path. However, it applies to the whole selection. 

Select your drawing and choose 5RWDWLRQ function from 
7UDQVIRUP submenu. Enter the desired $QJOH�value and 
select  the rotation axis from $FFRUGLQJ�7R Click Apply to 
accept. 
 
 
You can also click &WUO���)� to activate the Rotation 
function and your drawing will be enclosed with a blue 
Press and hold the left mouse button and move to the 
desired direction. You can also move the center to a new 
position and rotate the drawing around the center.  
 

 

Select your drawing then choose ,WDOLF function from 
7UDQVIRUP . Enter the desired the rotation $QJOH�value 
DQG�Flick $SSO\ to accept. 
 
 
You can also click 6KLIW���)� to activate the function and 
your drawing will be enclosed in a blue rectangle. 
Press and hold the left mouse button and move to the 
desired direction 
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&LUFOH���0XOWLSO\�DQG�%UHDN�FLUFOHV

Convert a circle into arcs of equal dimensions. 

 

The spacing: Corresponds to the distance between two arcs. Distance is measured by the unit of 
measurement used. 

Number: Indicates the number of arc that composes the circle. 
Close: Used to connect the ends of the arc with the center of the circle. 

�

�

6RUW�LQOLQH�SDWK�EHIRUH�RXWOLQH�

This option lets you automatically sort the paths and contours of your design.  
 
This function will reduce orderly manner, thus preventing the machine moving without cutting. Select your 
design, then from Tool menu, select the 6RUW�LQOLQH�SDWK«��function.   WinPCSIGN will automatically sort 
your design. 
 
 You can see the cutting sequence selecting 9LHZ�WKH�RUGHU�RI�REMHFW function�from 6KDSH�PHQX / 2UGHU� 
This function will show each path with numbers. 

�

6RUW�ILOOLQJ�RUGHU

This option allows you to automatically organize items by size. 
 
 Sort your objects from the smallest (foreground) to the largest (background). 

 

'LPHQVLRQ�OLQH��
 

Use this option to measure and determine the size of an object or the distance between them  
 

 

Choose�'LPHQVLRQ�OLQH��and the desired direction�(Horizontal, vertical, Diagonal or Angle.)�Click the first 
point then drag the cursor to the last point, drag the mouse in the position where  
you want the value to appear.  

           
+RUL]RQWDO�GLPHQVLRQ�OLQHV� 
 
Trace Dimension-lines to measure horizontal distances. 
�
3URFHGXUH�� 
1. Click on the first point that interests you. 

2. Move to the second point and click. 
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3. Click a third time to select the position of the text. 

1RWH��To create a customized dimension-line, you will need to select  
the 7H[W tool and click the dimensional-line’s text . A customized dimension-line must always have its Active 
Distance option deactivated. By default, the option deactivates automatically. 

 
�
9HUWLFDO�'LPHQVLRQ�OLQHV� 

Trace Dimension-lines to measure vertical distances. 

 

 

3URFHGXUH�� 
 
1. Click on the first point that interests you. 

2. Move to the second point and click. 

3. Click a third time to select the position  of   the text. 

�
1RWH���To create a customized dimension-line, you will need to select  the 7H[W tool and click the 
dimension-line’s text. A customized dimension-line must always have its  Active Distance option 
deactivated. By default, the option deactivates automatically. 
'LDJRQDO�FRWH�OLQHV� 

 

Trace Dimension-lines to measure diagonal distances 

3URFHGXUH���
�
1. Click on the first point that interests you. 

2. Move to the second point and click. 

3. Click a third time to select the position of the text. 

�
1RWH���To create a customized dimension-line, you will need to select the 7H[W tool and click the dimension-
line’s text. A customized dimension-line must always have its Active Distance option deactivated. By default, 
the option deactivates automatically. 
 
'LPHQVLRQ�OLQH�VHWXS��

          

This window will enable you to configure which measurement  unit is used, whether to include the unit or 
not, it is also used to determine the precision used. 

The Active distance option allows you to compensate for condensation. 
 
When you are satisfied, simply click on $SSO\ and the modifications will affect the selected dimension-lines 
and those that will follow. 

� �
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'LPHQVLRQ�OLQH�IRQW�FRQILJXUDWLRQ� 
 
This function will open the font window. Select the font used to display the measurements. 
 
When you are satisfied, simply click on $SSO\ and the modifications will affect the selected dimension-lines 
and those that will follow. 

 
'LVWRUWLRQ�

This function allows you to distort your text 

Select your text, and then from Tools menu, click 'LVWRUWLRQ�function. You can also press &WUO���.��from 
keyboard. WinPCSIGN will open distortion screen with a different distortion models. Select one or create 
your own using different tools from distortion screen. 
 
 

 

 

�

�

� �

1. Models: Selecting the desired distortion 
model. 
 
2. Methods of distortion: Choose the mode 
"Freehand"   "fixed form". 
 
3. Lines or curves type of envelope: The 
envelope curves can manipulate the shape of 
the curves. 
 
4. Work: Selecting keep the lines or conversion 
of lines to curves. 
 
5. Number of points: Selection of four or eight 
handles points  
 
6. Cancel / Apply: Click the Apply button when 
you are satisfied, or press Cancel button to exit 
and close the window without distortion 
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2XWOLQH
�

The�2XWOLQH�WRRO allows you create an external or internal contour to your texts and designs. You can create 
one or more contours with same or different distance. You can also create Outline from shadow or 
perspective. 

 

�

1. Thickness: Selection of the outline . Always use small values such as 0.10 or 0.25 inch (¼``) or 8% of the 
height of the letter. 

2. Number: Select the number of desired outline or contours. 

3.  Outline / inline: Normally means a path located outside of a selected object while an inner contour means 
a path within a selected object. The number and size of paths created inside of an object are limited by the 
size of the object. 

4. Contour: This function automatically welds the overlapping objects. You can change the space between 
letters using Visual text spacing function and manually move the individual letters spacing. 

5. Gradient: Creates a gradient background. 

6. Break text: This function enables separation of the original text of the created outline or contour. When not 
activated, the original text and the contour created will be grouped and won’t be separate. You must activate 
this feature if you want break the outlines from text or objects if you want to create contours of different 
thicknesses or different colors. You can also select this function from 7H[W�PHQX��%UHDN�WH[W� 

 

7. Sort: Arrange the filling order of objects or contours starting from the smallest to the biggest. This function 
shows the smallest object on top and the largest in the bottom of your ensemble. 

8. Fill color: Display the selected fill color. 

9. Corners model: Select three models to generate the corners of contours endings. 

10. Apply: Apply your settings to generate one or more contours of the same distance. 

� �
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�

6KDGRZ�

Create shadows of selected objects 
 
From 7RROV menu, click on 6KDGRZ. 

This application will enable you to create a shadow for selected objects, texts and elements.  
 

 
 
 
3URFHGXUH���
�
1- Select the desired element.  

2- From the 7RROV menu, click on 6KDGRZ. 

2-The Shadow window will appear select 6HW.  Orientation 

You must select the objects from which you want to cast a shadow and press 6HW.  You can determine the 
location of the shadow with different methods 
                                                       
 
Y polar coordinates: by moving the dial, you can determine the orientation of the shadow in relation to the 
original object. The angle (in degrees) will appear in the top window, to the right of the dial and the distance 
(from the center of the object to the center of the shadow) will appear in the second box from the top.  

By Cartesian coordinates: In the two bottom windows, you can determine the X and Y distance between the 
center of the original object and the center of the shadow.  You can also select the shadow and move it to 
the desired location using the mouse. Simply click and hold the left mouse button over the selected object 
and move it to where you want it to be placed, and release. When using this method, you will notice that the 
polar and Cartesian coordinates will be modified accordingly. 
 
1RWH��The unit used in measurements is the one selected in the 6HWXS (6HWWLQJ menu). 7\SHV�RI�VKDGRZV: 

 
 
If you have several elements overlapping each other, you can determine whether you want their shadows to 
be welded together into one single shadow or whether each of them should constitute an individual element.  
To do so, you must decide if you want to use ZLWK�ZHOGLQJ�option. You can also select the method of 
creating shadows. Selecting 1RQH will mean that that the shadow will be identical to the original object. 
'URS will create a shadow made only of the visible portion of the shadow (in cases where the original object 
overlaps the shadow). The 'URS���EDFN�option will create a welded copy of the original object WITH its 
shadow. This welded shadow will appear over the original image. To modify the color of the outline of the 
shadow, simply click on the color rectangle to access the color palette.  
 
To accept the type and direction of shadow, simply click on the checkmark. To cancel the creation of a 
shadow, click on the door. OR Another way to create shadows is to go to the 6KDSH�menu, :HOGLQJ�
submenu, and click on 6KDGRZ��

� �
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6KDGRZ�ZLWK�WUDQVSDUHQW��
 

This function enables you to create a selected object’s shadow with a transparent effect. To create this 
shadow, you must determine in what direction it will be cast, the distance in relation to the object, and the 
shadow’s color. 

 

    
 
 
The “°” symbol represents the angle of the orientation of the shadow when compared to the image from 
which it originates. “D” represents the distance between the image and its shadow. When you are satisfied 
with the selected parameters, press on $SSO\. 
 
If want to remove an object’s shadow, just select the object and press &DQFHO. If you choose to keep the 
shadow, you should now that it is possible to move it around independently from its originating object by 
dragging it with the mouse. It will still be lined to its originating object.  After moving the shadow, 
 if you want to move both shadow and object, deselect your shadow (by clicking elsewhere), and click the 
object. Both the object and its shadow will move together again. 1RWH��To modify an existing shadow, you 
must use the same window. 

+LQW��7R create a shadow that does not seem to originate from an object, you must create that object, apply 
a shadow to it, and remove the pen and brush color from the original object.  You can also place a distance 
of 0 between the object and the shadow. 

 
*UDGLHQW

This option allows you add color gradient to your design  

 

Procedure: 

Select your design, and then click Gradient function. WinPCSIGN will open the *UDGLHQW�FRORU�VFUHHQ. 
Select the desired model (1) Linear, Rectangular, Circular or image. Then, the number of colors (2) or click 
the line to add new color (triangle). You can also select a gradient angle 90 degree (3. To select or change a 
color, double-click one of the triangles. 

In the same screen, you can create a mask image using an image. Enter the text from the screen and then 
select the image model (1). Then from your files, select an image. For mosaic can disable the option. Finally, 
press 2.� 

� �
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'LIIHUHQFH

This function allows you to weld two elements by merging the largest object in the smallest 

 

�

:HOGLQJ�
 

:HOGLQJ�SOXV�
This function allows weld two elements by fusing the smallest object to the largest. 

 

�

:HOGLQJ�FRORU�ZLWK�SHQ�
This function allows weld…... 

�

�

:HOGLQJ�
This function allows weld all elements selected by fusing them 

 

  

Select your items, then select 'LIIHUHQFH from the 
Tools menu. WinPCSIGN will automatically merge 
the elements 

Select your items then select :HOGLQJ�3OXV, from   
Welding menu. WinPCSIGN will automatically merge the 
elements. 

Select your items then select :HOGLQJ�
from Welding menu. WinPCSIGN will 
automatically merge all the elements. 
 



 WinPCSIGN manual 

      75 
 

 

 

 
(QJUDYLQJ�,QVLGH�2XWVLGH

 This function allows you preparing a text or drawing to engrave with a machine or with Diamond 
engraving tip. 

 

(QJUDYLQJ�,QVLGH�

 

(QJUDYLQJ�RXWVLGH�

 

Engraving Island 

 

  

Engraving filling screen  
 
 
1. Tools, enter the value of your wick 
(Diamond engraver recommends 0.01) 
 
2. The number of passes. 
 
3. Final cleaning line 
 
4. Style: different kind of engraving sweep 
Line. (individual lines) S-Sweep (sweep 
connected lines), Island (circular 
engraving) 
 
5. Keep the original line 
 
6. Add a color 

This option allows you to add lines to create internal engraving effects, 
reliefs. 
 
From Tools menu, select (QJUDYLQJ���,QWHULRU. Then from engraving 
screen, choose the desired filling functions. 
 
Example: Line Tools 0.01 and original path selected. 

This option allows you to add lines outside of your selection 
to create engrave relief effects. 
From Tools menu, select (QJUDYLQJ���RXWVLGH. Then from 
Engraving fill screen, choose the desired filling functions. 
 
Example: 0.01 line tools selected 

This option allows adding circular internal lines to 
your selection to create a bas-relief engraving. 
 
From Tools menu, select (QJUDYLQJ���,VODQG� Then 
from Engraving fill screen, select the desired filling 
functions. 
 
Example: Tool 0.01 
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&RORU�6FKHPH���

Add color to your palette 

This feature lets you add color to your palette from an image present on working screen. 
 
Procedure:  
Paste an image from the Internet or from the scanner or camera to WinPCSIGN working screen, and then 
select &RORU�6FKHPH icon, WinPCSIGN automatically add all the colors found on your image to the color 
palette. 

 

If you want to keep the new color on the palette, click  icon in Color palette. 

&RORU�WUDSSLQJ��
�

This function allows you to create an overlap for your artwork which compensates for the inherent 
inaccuracies in the Screen Printing process. 

 
Before selecting this option you must have at least two colors on screen which overlap each other. 

 
Choose &RORU�WUDSSLQJ�from the 7RROV�menu. Draw a window with the mouse around the objects. 
WinPCSIGN will open the 2YHUODS�dialog box and you will choose the overlap distance. 

 
Superimposition of colors will help you respect the common borders of different colors. It creates a security 
zone around adjacent elements. This outline will prevent light from penetrating and will prevent the 
apparition of white lines or new colors. 

 
When printing, color trapping will help you preserve the integrity of  each color, but to do so, you will have to 
select in the dialog box the lighter colors first, the darker tones later. 

 
This function is useful when cutting vinyl. It will allow you to create overlapping outlines.  To o so, select 
the drawing you want superimposed and select &RORU�WUDSSLQJ from the�7RROV�menu. A color dialog box 
will appear. If you are printing, select the color order and click 2.. 

 
'RXEOH�OLQH��

�
This function allows you to convert singles lines to doubles lines  
 
Procedure: 
Draw o select your design (black and white), then given a desired thickness. Choose 3HQ��%UXVK�from 
Setting menu and enter the desired :LGWK�value for the lines (Pen). Select 'RXEOH�OLQH�function and then 
from 5HVROXWLRQ�VFUHHQ. Select the desired conversion value /RZ, 0HGLXP or +LJK�and click 2.� 
�

�
�
�
�

� �
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3HUVSHFWLYH��'� 
 

6KRUWFXW���  
 

This function enables you to create a perspective effect on the selected elements.  

 
 
Example of possible effect: 

 

     

�
�
%DFNJURXQG��Represents the assigned depth. The value ranges from 0 to 1. 
3RLQW�;<: Corresponds to the point to which your design is going. 
6DYH: Saves the values selected. 
2SHQ: Recovers saved values. 
%ORFN: Remove the perspective  
�
�
5RWDWLRQ��'��

�
This function allows you to rotate your selection in all directions 
 

 
 
Select the text, and then from the 7UDQVIRUPDWLRQV�VFUHHQ, choose the desired rotation ;��<��=. Once your 
rotation is of your liking, click OK (checkmark) to accept 
 

�
�
�
�

� �
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&RQYHUW�3HQ�WR�GRXEOH�OLQH��
 

This function allows you to convert an uncuttable drawing with singles lines in a cuttables drawing. 
 

Once the image is vectorize with &HQWHUOLQH� Choose  the desired pen size from the�6HWWLQJ menu then 
select 0DNH�GRXEOH�OLQH from the 7RROV menu. The 5HVROXWLRQ�box dialog box will be displayed. Select the 
desired resolution and press 2N to start. 

 
 

 
�

�
6WHQFLO�%ULGJH�

 
You can create stencils with text or drawing. 

 

 

 

 

  

Select your text and then from Stencils screen insert the 
desired value for the thickness of the connecting bridge 
between each letter, then start drawing the first bridge 
with the mouse. This should VWDUW�and HQG outside of 
your text. We recommend you start drawing from left to 
right by pressing the left button. Release the button when 
the bridge touches the object or letter. 
 If an object has two paths, you must draw two bridges.  
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%LWPDS�PHQX�
�
&RQYHUW�WR�DQ�LPDJH�

 
Create from selected elements an image on the screen. This option is recommend to review the final quality 
of your image before to export or send to a web page.  

 
3URFHGXUH��

�
1. Select the desired elements. 
2. From the %LWPDS, click on &RQYHUW�WR�LPDJH. 
3. Select the resolution XY96 dpi  (for the screen) 
4. Select a white border( if you don’t want enter zero ) 
5. Press OK to see your image converted 

 
Caution: This command is not the right saving option to save a file aimed for vinyl cutting. 

 
&UHDWH�IRU�ZHE��

 
Enables user to create a quality image to be used on the internet  
 
+LQW�� 
It is best to work with units displayed (Pixel). See unit Create page with necessary dimensions for your 
image. For example to create a 64x64 images simply create a page of that size and when you are done, 
select everything. 

 

�
�

The border option surrounds the image of additional pixels. If the 2Q�ILOH option is selected, the image is 
transferred to a file called “web. jpg” in the “images” directory.  You also have the option of creating an html 
file. Simply select the &UHDWH�KWPO�ILOH option. If the option is activated, you can select the location 
 where the file will be copied by using %URZVH.  
 
If the 2Q�ILOH option is deactivated, the image will be placed in the Windows clipboard. To access file, use the 
Paste function in the (GLW menu. 
 

� �
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6HH�RQ�VFUHHQ� 
 

�
.H\ERDUG� �� Alt + E 
 
This command displays the selected images according to their size on black screen. 
  
 
6RIW�WRXFK��  

�This option will soften portions of the image found under the cursor. 

 
 
�
1RWH���You can modify the size of the affected softening region by using different methods: 

 
 a) - By increasing or decreasing the dimension value.  
 b) - By pressing on  “+” or “-“. 
 c) - By double clicking anywhere on screen. 

 
You can modify the effect of the softening by using different methods: 
 
a) - By sliding the window’s scroll bar 

               b) - By pressing Shift and (+ or -). 

              :H�UHFRPPHQG�VDYLQJ�\RXU�LPDJH�EHIRUH�WR�PRGLI\�LW�
                           

������������7RXFK�XS���
 

 
This function enables you to improve and make modifications on an image. 

���

   

 
 
 
 
4.-To make a correction, simply left click on the desired portion of the image. To make continuous 
corrections hold the left mouse button while making your touch ups over the desired regions. 7KH�
FRUUHFWLRQ�]RQH�ZLOO�IROORZ�WKH�PRYHPHQWV�RI�WKH�PRXVH� 
,16(57 key once. To return to a moving correction zone, press the INSERT key a second time 

5. To limit the possible movements while making your corrections, simply hold the 6+,)7�key. You will only 
be able to move horizontally or vertically from the location where you pressed the 6+,)7 key. 
 
               
1RWHV���
a).To change the dimension of the correction zone, simply double-click the circle. You can enter a value for 
the new dimension. The dimension is measured in pixels. You may also use the dimension window that 
appeared when the function was activated. (See image above). 

 
b).The correction zone can be moved two different ways:  

 
1. Press &WUO and the left mouse button above the desired region. 
2. Left click and hold the mouse, and move above the desired region. Release when done. 
 
To integrate a portion of an image over another, simply place the correction zone on the second image and 
go to the third step of the procedure mentioned above. 

  

3URFHGXUH��
�
1.- Select 6RIW�WRXFK from  the %LWPDS       
                     
2.- Click and hold the mouse over the region of   
the image that needs to be softened. 
 

3URFHGXUH��
�
1-From the %LWPDS menu, select 7RXFK�XS. 

 
2-Next, you must determine the size of what will be called the 
“correction zone”,  that is, the zone that will be used to make your 

corrections on another portion of your image.  
 
3.- Using the mouse, place the cursor at the location where you wish 
to place the Correction zone. At any new Correction zone, you can 
either click and hold the left mouse button on the present location and 
drag it to another location, or you can simply hold the &75/�key and 

click at the desired new correction zone.  
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�
0HUJH�VHOHFWHG��

 
This option lets you edit a bitmap and merge their changes 
 
Each time you work in an image drawing or writing, this objects are not part of the image; this option, allow 
you to merge them with your image. 
 
Place your text or drawings on the image that you want to merge. Select the icon and click on the image. 
WinPCSIGN will merge automatically your choice to your image. This function can be cancelled by selecting 
the red X. 
�
9HFWRUL]DWLRQ�

�
9RLU�OH�FKDSLWUH�*UDSKLFV�VRXUFH�DQG�YHFWRUL]DWLRQ�
�
�

9HFWRUL]DWLRQ�3KRWR�&XW�   
 

This method will enable you to reproduce black and white or 256 shades of gray photo into vinyl. 
 

Example:  
 

 
 
3KRWR�FXW�6HWWLQJ�
Parameters by default used in configuring photo cut. 

 
 
([SODQDWLRQ��Number of lines to cut : Lines to cut an image. The higher the number is, the more precise the 
image will be. The number of possible lines varies with image. Minimum distance:  Minimal distance 
accepted between white line and black line. &RQQHFWLRQ: Zone used to detach vinyl strip. This zone can be 
placed either on the left of the right of the image. The thickness of it is defined by the connection zone. 
 
9HFWRUL]DWLRQ��&HQWHU�OLQH�

 
Center line is a type of vectorization for black and white images. 
 
This function allows you vectorize a black and white image, offering a simple line in the middle of each letter 
or closed path. This feature is excellent for producing texts for Engraving and Rhinestone. You can also 
make plans for neon. 

 
�1RWH�� If your image is not in black and white or 256 shades of gray, you must modify your image. 
�
3URFHGXUH�WR�FKDQJH�DQ�LQWR�EODFN�DQG�ZKLWH��
 
1-From the %LWPDS menu, select Change resolution 
 2-Select 1 as the number of bits per pixel. 
 3-Repeat procedure described above.. 
�
3URFHGXUH�WR�FKDQJH�DQ�LPDJH�WR�VKDGHV�RI�JUD\��
 
1-From the %LWPDS�menu,�6SHFLDO�HIIHFWV� select Image transformation  
2-Click on Gray, click $FFHSW.  
3-Repeat procedure described above.  

  

3URFHGXUH���
�

From the %LWPDS menu, select PKRWR FXW���Click on your image. 

1.- From %LWPDS�� 9HFWRUL]DWLRQ submenu, select &HQWHU�OLQH. 

 2.- Click on the image that you want to obtain the center line. 

 3.- Select yes when prompted.. 

�
1RWH��This function is only valid for images in shades of gray.  

If you have a color image you must convert it.  
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9HFWRUL]DWLRQ��(GLWLRQ���3UR�DQG�%DVLF���

�
7KLV�PHQX�DOORZV�\RX�WR�FRORUL]H��'HOHWH�DQG�9HFWRUL]H�DQ�LPDJH�

�

�

�

�

�

�

�

�

�

�

�

�
�

� �

Enhances the details of an image using: 
/LQH��3RLQW��3RO\JRQ�or�5HFWDQJOH� 
 
 
 
Colorize an image by 5HJLRQ�or $OO 
 
 
 
Vectorize image by parts using: 
�$YHUDJH��&XS�or�3ODQH 

Select eyedropper icon from color palette, then move it over the image to pick 
up the color that you want to apply. Select the desired option: Line, Polygon, Point 
or Rectangle and click the icon 6SUD\. Draw or click in the area of the image to 
correct. WinPCSIGN will take the selected color and will be merged with the 
Bitmap. 

Use this function for painting a group of pixels using 5HJLRQ or $OO��LQ�
accordance with a selected color from palette  

This feature allows you vectorize an image par section. Select $YHUDJH�and�
click the ,FRQ, then click in the image area that you want to convert to 
vector. (click on the left side of your image). The vectorize result will appear 
on the right side of your image. 
 
The vectorize lines can be corrected by using the features available in the 
0DQLSXODWLRQ�EDU� You can also use 6LPSOLI\�SDWK function from 6KDSH�
PHQX��:�&XUYH��
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�

�

�

5HJLRQ

This function allows you to cut or copy a part an image drawing a 5HFWDQJOH, an�2YDO, a &LUFOH or a 
3HUVRQDO�SDWK����
�
You can use a rectangle, a circle, an oval and a custom object or text to capture a portion of an image. 
Procedure: Select 5HFWDQJOH��2YDO�or &LUFOH� from 5HJLRQ� Then use the mouse to draw the region that you 
want to copy or paint on the image.  Finally select the copied region and move it to a new position on the 
screen.�

Procedure:  3HUVRQDO�SDWK: Draw a desired shape or write a text over your image, then select 3HUVRQDO�
SDWK from 5HJLRQ�and click on your path. WinPCSIGN will you show the selected region screen. Press 1R�
to copy a region: 

 

 

If you select <HV, WinPCSIGN will merge your selection with your image.  

 
 You can also capture a personal path, selecting capture icon from Zoom bar: 

 
 
Draw your shape and click on the icon, WinPCSIGN will make a copy of the image with your shape 
automatically. 

RHPRYH�UHJLRQ�� �
�

7KLV�RSWLRQ�HQDEOHV�\RX�WR�UHPRYH�DQ�LPDJH¶V�UHJLRQ��
When you insert a region in an image, this region will be transparent, like a hole in the image. Select            
 
5HPRYH UHJLRQ, you will be able to return to your original image. Do not forget to select the image before to 
activate this option.        
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&RORU�

�

&RORU�UHVROXWLRQ�

This option lets you change the resolution of an image between 1 to 32 bits per pixel.  From the Bitmap 
menu select Change Resolution and select the desired bit per pixel 

&RORU�VHSDUDWLRQ��
This function separates a color image into several images representing different color plans. 

 
 
The different color plans available are : RGB (Red, Green, Blue), CMYK (Cyan, Magenta, Yellow, black) et 
CMY (Cyan, Magenta, Yellow). 

By default, the images are created in shades of gray. Select the With color option to obtain images in color. 
���������������������������
3URFHGXUH���

�
  1- Select the images you want to transform. 

  2-From %LWPDS menu,  select &RORU�VHSDUDWLRQ. 

  3-Select your color plan and click on $FFHSW�button. 
 
5*%�H[DPSOH� 

 
�������������
 
+XH�� 

This option lets you adjust the nuances of a picture. By selecting Hue nuanced on screen you can change 
the value of the color rotation angle.  Changes made with this option can be cancelled only on the color 
shade screen. 

1HJDWLYH�
 
This option lets you convert a color image into a negative image. From the Bitmap menu, 
selects Negative and click the image. 
 
Note: The images produced on film by a Photocomposed are generally negative. 

�
&RORU��GHWHFWLRQ�LQWHQVLW\�
�
This option can be use for detecting the intensity of default colors of an image. 
After importing an image JPG, BMP etc. or scanned, you can work the intensity of it. Select 
the required value from floating screen. Click OK to accept or Cancel. 

�
&RORU��$GMXVW�+DOI�WRQH�

This function recalibrates an image in an image area corresponding to 100% and a white area of the image 
corresponding to 100% black. 

Procedure: From the Bitmap menu, select the from $GMXVW�+DOI�WRQH from &RORU. 

-Click a section or area of the image which represents the color white. 
-Click on a section or area of the image that represents the black. 

Note: Your selection of areas or sections must come from the same image. 

� �
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&RORU�WUDQVIRUPDWLRQ�

With this option you can set the color of an image: 6DWXUDWLRQ��*DPPD��%ULJKWQHVV�and�&RQWUDVW� 
As you increase the changes to your image, it will change on the screen. Once you will be satisfied with your 
results, click $SSO\�or click 5HVHW�to start 

Saturation: (Definition) color pure unadulterated, this component determines the intensity of a color. 

Gamma: (Definition) Color Mixed 

Contrast: The difference between the dark and light colors in an image. A higher value gives a contrast 
between the color ranges. 

Brightness: Measure the brightness of the pixels of the picture clearer regarding the darkest pixels or darker 
tones means. To increase in specific intensity, it needs the white without changing the blacks 

�

'LVWRUWLRQ��
�

 

3HUVSHFWLYH�� �
 
This function enables you to give a perspective effect to an image. 
 

 
 

To apply a perspective effect on an image you just have to move the red dots on the extremities of the 
image. Click on $SSO\�to keep the results. 

 
3URFHGXUH���
1 From the %LWPDS menu, select 3HUVSHFWLYH� 
2 Click on the desired image. 
3 Apply the perspective. 

 
 
               'LVWRUWLRQ��)UHH�KDQG�ZDYH�

This function allows you to apply Wave effects to an image. Choose your image, and then selects the 
desired options from the screen. 

'LVWRUWLRQ��:LQG�

This function allows you to apply Wind effects to an image. Choose your image, and then selects the desired 
options from the screen. 

'LVWRUWLRQ��3RODU�

This function allows you to apply Circular effects to an image. Choose your image, and then selects the 
desired options from the screen. 

'LVWRUWLRQ��=RRP�ZDYH�� 
This function allows you to apply Perspective effects to an image. Choose your image, and then selects the 
desired options from the screen. 

'LVWRUWLRQ��5DGLDO�:DYH�

This function allows you to apply circle-shaped effects to an image Choose your image, and then selects the 
desired options from the screen. 

'LVWRUWLRQ��6ZLUO�

This function allows you to apply Spiral effects to an image. Choose your image, and then selects the 
desired options from the screen. 

� �
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'LVWRUWLRQ��:DYH�

This function allows Distort your image Choose. your image, and then selects the desired options from the 
screen. 

'LVWRUWLRQ��6KHDU�:DYH�

This feature lets you stretch your image. Choose your image, and then selects the desired options from the 
screen. 

�
�'�HIIHFWV�

�

(PERVV�
�
Depth effect for image. 
 
Adjust the direction of the desired brightness; the value can vary between 1 and 1000. Higher number will 
give a stronger effect. 

�

�

�5LSSOH�

This function allows you to apply ZDWHU�effects to image. Choose your image, and then select the desired 
option from ripple screen. 

%HQGLQJ��

This function allows you to apply &XUYHV effects to images. Choose your image, and then select the desired 
options from bending screen. 

&\OLQGULFDO�

This function allows you to apply &\OLQGHUV�effects to image. Choose your image, and then select the 
desired option from cylindrical screen. 

6SKHUL]H�

This function allows you to apply 6SKHULFDO effects to images. Choose your image, and then select the 
desired option from spherize screen. 

� �

Choose your image, and open (PERVV�
function. WinPCSIGN will open the emboss 
screen. Select with the mouse the desired effect 
of depth (3D). Then select the address. 

 
 
This option provides different angles. Click 2. 
to accept. 
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6SHFLDO�HIIHFWV��
�

1RLVH�

This option gives a different effect to an image, creating a steep uneven appearance, texture in a flat design. 

 

��������������

,PDJH�WUDQVIRUPDWLRQV�

This option allows you to transform a picture, seeing the changes you apply. 

�

7KLV�ZLOO�DSSO\�IROORZLQJ�IXQFWLRQV��

  -Emboss: To convert the image to gray and relief. 
  -Vip: Soften an image. 
  -Sharpen: Change the image intensity. 
  -Reduce Noise/Noise: Implement a sudden appearance of noise, uneven texture. 
  -Gray, Convert your image in greyscale. 
  -Equalize contrast. 
  -Reset: This function allows you to return to your original image��
  -Apply: Accept the changes and exit. 

:H�UHFRPPHQG�WKDW�\RX�PDNH�FRSLHV�RI�\RXU�RULJLQDO�LPDJH�EHIRUH�VWDUWLQJ��

3DLQWLQJ�HIIHFW� 

This function enables to give a painting effect to your image. The higher the value, the more the effect will be 
accentuated. 
 
 

 
 

By adding noise to a background color image, it will 
give a fuzzy appearance. 
 
Reducing noise will reduce the sudden appearance of 
a color flat too unequal. 
 
Select All, Red, Green or Blue. Enter a desired  value 
between 1 and 999 and click OK. 
 
You can cancel clicking the ; red on top. 

3URFHGXUH�� 

1-From the %LWPDS menu 6SHFLDO�HIIHFWV submenu, 
click on 3DLQWLQJ�HIIHFW. 
2-Click your image, select a value from the Painting 
effect  
3-Click OK button, to accept your choice. 
 
Accept is for the first image to left. 
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,PSUHVVLRQLVWH�

This function allows you to apply painting effects of an image. Choose your image, and then from 
Impressionism screen, select the desired options. 

3L[HODWH�

This function allows you to apply Pixelate effects of an image. Choose your image, and then from Pixelate 
screen, select the desired options. 

0RVDLF�

This function allows you to apply Mosaic effects of an image. Choose your image, and then from Mosaic 
screen, select the desired options. 

3LFWXUL]H�

This function allows you to apply pictorial effects by combining two pictures. 

Choose your image, and  then from Picturize screen, select the directory where the other image is. Then 
select the type of scaling (resizing) and quality. Press OK to activate. WinPCSIGN will take the image from 
your file and will merge it with your image creating a pictorial effect 

 

 

5RWDWH�LPDJH�
�

���GHJUHHV��
To rotate your image 90 degrees, select this option then point the mouse on your image. The rotation will be 
applied. 

����GHJUHHV��
To rotate your image 180 degrees, select this option then point the mouse on your image. The rotation will 
be applied. 

�����GHJUHHV��
To rotate your image 270 degrees, select this option then point the mouse on your image selection will be 
applied. 

&XVWRP�$QJOH��
With this option, you can rotate entering your angle value. Select this option and click on your image. Then 
from the floating window enter the desired value and weigh Ok. 

�

�
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,WDOLF�LPDJH

This feature allows you to place an image in italic. 

Select the ,WDOLF�LPDJH from %LWPDS�PHQX. Once this option is selected, click on the image. The angle 
screen will appear, enter the value of the desired angle and peak OK. 

 

This application can be canceled after accepted with the ; red from top bar. 

�

)OLS�LPDJH�XS�GRZQ

This option will place a mirror image vertically. 

Select the )OLS�LPDJH from %LWPDS�PHQX, once activated, click on the image, it will automatically be rotated. 
This application can be canceled with the�;�option from top bar. 

�
�

�

0LUURU�LPDJH�/HIW�ULJKW�

This option places a n image horizontally mirror. 

Select the 0LUURU�LPDJH option from %LWPDS�PHQX, once activated, click on the image, it will rotate 
automatically. This application can be canceled with ;�option from top bar. 

�

� �
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�

�

&RORU�FDOLEUDWLRQ�

This function will be used to color calibration for an image to print 
 
Select the function from %LWPDS�menu and click on the image. The program will display the &RORU�
FDOLEUDWLRQ screen: 

 

To calibrate, select $// color to be calibrated, or &\DQ, 0DJHQWD, <HOORZ�or %ODFN. Then move the diagonal 
line to the nearest point on the desired percentage color. Move the mouse to the place for you to lighten or 
darken the color. The result will be obtained in the current preview screen for the treated color.  

,QWHUSRODWLRQ�6WDQGDUG�$YHUDJH
�

This function is used to enlarge the size of an image, all while keeping original quality. 
��
3URFHGXUH����
 
1- Select image. 
2- From the %LWPDS /,QWHUSRODWLRQ select 6WDQGDUG.  
3- In the Interpolation screen, enter a numerical value. The enlargement factor of this value will modify the 
height and length of the image. 
For DYHUDJH�LQWHUSRODWLRQ, the value must be full or with decimals. 
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�
�
�
�
5HGXFWLRQ��

�
To reduce the size of an interpolated image 
 
While keeping the quality of the original image, the reduced image, takes up less memory space. 
 
Procedure: Select the Reduction from Bitmap menu. Then from reduction screen, type the reduction factor 
and click OK.  
 

 
 
The reduction factor is calculated this way:  
Size of the original image divided by the size of the desired image. (ex. 12/4 = 3.) So the factor is 3. 
�
+LVWRJUDP��

 
This diagram represents the range of luminance of an image�  Display histograms of the colors of the 
selected image. 
 

�
�
This option will show you the colors chosen plan with its color according to the intensity distribution image. 
You can choose the desired color or all colors in an image. 

�
�

$GMXVW�KLVWRJUDP� 
 

This option allows you to adjust the luminance of the image.   
 

�
�

  
Adjust color intensity with a percentage value. The adjustments will be made to all 
selected images 
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�
)LOWHUV��

 
Apply a filter to selected images. 
 

 
 
 

 
 
 
�
�
�
$GG�%RUGHU�

�
 

 %RUGHU�
This option allows you to add borders around  your image using another. 

�

� �

This option allows you to apply a filter on an 
image by giving it a brighter or darker effect. The 
selected filter can be applied in different ways in 
the selection of operations available to apply the 
filter. 
 

Options allow: Reverse the effects of the mask, Invert 
the original image or choose a Personal Image. 
 

Choose your image on the screen, select $GG�
%RUGHU /�%RUGHU�from�%LWPDS�PHQX. WinPCSIGN 
will open the importation image screen. Select the 
folder where the image that you want to use to create 
the border is. Then from the Add Border screen 
select the desired options. 

Once the choice is made, press 2.�button�to accept. 

We recommend that you make copies of your original 
image before starting, because cannot be recuperate 
with red X 
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�

)UDPH�

This option allows you to add frames around your image using another. 

�

�

�

�

� �

Choose your image on the screen, select $GG�
%RUGHU /�)UDPH�from�%LWPDS�PHQX. WinPCSIGN 
will open the importation image screen. Select the 
folder where the image that you want to use to 
create the border is. Then from the Add Frame 
screen select the desired options. 

Once the choice is made, press 2.�button�to 
accept. 

We recommend that you make copies of your 
original image before starting, because cannot be 
recuperate with red X 
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��

6KDSH�PHQX�
�
�
*URXS�Ctrl+ G�

�
To group elements texts, logos or designs 
 
Select with the mouse the elements to be grouped. 
Then point in *URXS�from Shape menu�or select &75/���* from your keyboard.  
WinPCSIGN will automatically all selected items in one element. 
 
You can create multiple groups in an assembly can apply a change simultaneously its entirety. This makes it 
easy for travel. 
 
Note: Several tools work only with non-grouped elements. 
�
7UDQVSDUHQW�JURXS��

�
This option allows s you to make common portion transparent.  
 

 
This tool will enable you to group several objects together to create a single object. If the objects are 
grouped, the overlapped regions will be removed to create transparencies. These transparent regions 
enable you to see the objects placed in the background. 
�
3URFHGXUH��� 
1-Select your drawing or document. 

2-From the 6KDSH menu, click on Transparent group  

�
1RWH���The group will take on the color of the first object placed. To remove, select %UHDN�DOO function 
 
 
%UHDN�DOO�Ctrl+ U��

 
 
This function allows you to break all groups contained within a larger group into elements. This tool will break 
the larger group as well as the smaller groups composing the larger group. 
�
�1RWH��It is important to have the groups in selection before proceeding. 
 

 select tools 
 
 
 
2UGHU�

�
This option is used to rewind or forward the selected items in your selection. 
�

�
�
�
%DFN�RQH�
Select your item and then, click�%DFN�RQH from�6KDSH�PHQX�/ 2UGHU� The application will run automatically. 
This function can also be activated selecting 3J��'RZQ�from your keyboard.  The cup, 1 step back: 
�

�
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)RUZDUG�RQH�

�
Select the item to move, then choose )RUZDUG�RQH from 6KDSH�PHQX���2UGHU� The application will run 
automatically. This function can also be activated selecting 3J�83� from your keyboard. 
The cup is one step front: 
�

�
�
7R�%DFN�
�
Select the item to move then choose TR�%DFN�from�6KDSH�PHQX���2UGHU� The application will run 
automatically. This function can also be activated, selecting 6KLIW���(QG from your keyboard.  
The cup, 2 step to back: 
�

�
�
�
7R�IURQW�
�
Select the item to move, then select 7R�)URQW from�6KDSH�PHQX���2UGHU. The application will run 
automatically. This function can also be activated selecting 6KLIW���+RPH from your keyboard.  
The mug is first place: 
�
�

�
�
�
'LVSOD\�RUGHU�REMHFWV�
�
This option is used to see in which order your design or text will be cut or engrave 
 
Select your assembly, then choose 'LVSOD\�RUGHU�REMHFW�from 6KDSH�PHQX���2UGHr menu. WinPCSIGN will 
show your elements with numbers 1,2,3,4,5 ...... .. 

 

 

Hint: The quantity of numbers will be reduce if you group your assembly   
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  �

�
�
�
-RLQ�DOO��

�
To join any open points. 
 
This option allows you to automatically connect all the points that are not connected. 
Note: It is best to use the Close all path to close all open points. (Open points in a design, are shown with a 
circle) 
 
(QFORVH�DOO��

 
This option allows you to close all paths open to a selected object. 
 
Select the (QFORVH�DOO function in the menu. WinPCSIGN will automatically join the disconnected paths by 
adding a line if necessary 
 
�
6HH�RSHQHG�SDWK��

�
This function show all the unconnected point (node) 
 
This function is activated all the time (default) so you can see the points that are not snap. 
 WinPCSIGN will show the open points in your design with circles: 
�

�
�
�
�
6HH�GLUHFWLRQ��

�
���������   This option allows you to see the direction in which the paths will be cut. 

�
�
�
6LPXODWLRQ�

 
This feature shows the movement in the direction in which the path will be cut or engrave 

Select the object and choose 6LPXODWLRQ�IXQFWLRQ��The program will simulate the movement. 
This is used in combination with the 6HH�GLUHFWLRQ function. 

�
5HYHUVH��$OW�,�

�
This option allows you to reverse the direction of the trajectory of the path in your design. 

Select an item, and Reverse function. WinPCSIGN will automatically change the direction of the trajectory. 
This is used in combination with the functions�6HH�GLUHFWLRQ and 6LPXODWLRQ 

�
0RYH�SDWK�WR�VWDUW�SRLQW�

This option allows you to move the starting point of a selected element. 

Select the function and click on the object where you want set the new start point. The changes will be 
applied automatically. This is used in combination with the management functions See & Simulation 

� �

As soon as you select 6HH�GLUHFWLRQ function, .WinPCSIGN will 
show you the selection with arrows pointed  the cutting direction. 
 
It is better to work with this function without selecting construction 
points  

If there is opened points in your design, you can choose one of these options: 
 

-1st Option: Use the -RLQ�DOO the points. 
 

-2nd Option: In the Manipulation bar, select the Joint two points function. Then 
using the mouse to connect the point. 

 
-3rd Choice selects function &ORVH�DOO�SDWK� 
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�

�
�
0DNH�RULHQWDWLQJ�SDWK��

�
This function allows you to orient the cutter blade to cut out in the right direction. 
 
 WinPCSIGN automatically select the best starting point for each object. 
�

�
�
�
&XUYH�WUDQVIRUPDWLRQ��

�
�
&KDQJH��WR�VHJPHQW�

This function allows you to convert a path consisting of mixed objects into VHJPHQWV. 

Select your design or path, and then click on &KDQJH�WR�VHJPHQWV, the selected path will be automatically 
converted into segments.  Select &RQVWUXFWLRQ�SRLQWV function to see the result. 

&KDQJH�WR�%H]LHU�FXUYHV�

This function allows you to convert a path consisting of mixed objects in %H]LHU�curves. 

Select your design or path, and then click on &KDQJH�WR�%H]LHU�FXUYHV function. The selected path will be 
automatically converted to Bezier curves. Select &RQVWUXFWLRQ�SRLQWV function to see the result. 

&RQYHUW�WR�$UF�

This function allows you to convert a path consisting of mixed objects in $UFV. 

Select your design or path, and then click &RQYHUW�WR�$UF function. The selected path will be automatically 
converted into�$UFV. Select &RQVWUXFWLRQ�SRLQWV function to see the result. 

&RQYHUW�WR�VPDOO�VHJPHQW�

This function allows you to convert a path consisting of mixed objects into VPDOO�VHJPHQW� 

Select your design or path, and then click &RQYHUW�LQWR�VPDOO�VHJPHQW�function.  The selected path will be 
automatically converted into VPDOO�VHJPHQW. Select &RQVWUXFWLRQ�SRLQWV function to see the result. 

We recommend select this function if you want to cut a design extremely slow  

&KDQJH�WR�%H]LHU�FXUYHV�DQG�VHJPHQWV�

This function allows you to convert a path consisting of mixed objects to Bezier and segment. 

Select your design or path, and then click &RQYHUW�WR�%H]LHU�VHJPHQW function, the selected path will be 
automatically converted to %H]LHU�DQG�VHJPHQW. Select &RQVWUXFWLRQ�SRLQWV function to see the result. 

&KDQJH�WR�ORQJHU�VHJPHQW� 

This option allows you to extend the segments of a selected path. 

Select an object to convert, and then click &KDQJH�WR�ORQJHU�VHJPHQWV��All your selection will automatically 
convert into long segments. Select &RQVWUXFWLRQ�SRLQWV function to see the result. 

&RQYHUW�WR�WKH�SRLQW�RI�HTXDO�GLVWDQFH�
 Read rhinestone chapter 
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�
�
6LPSOLI\�SDWK��$OW�3��

�
This option allows you to remove points in a vectorize path.  
 
This option is very useful to eliminate unnecessary node. Once your image is vectorized (convert pixels to 
vector) choose your design or logo and click 6LPSOLI\�SDWK�from 6KDSH�PHQX� WinPCSIGN will open �
:�&XUYH screen. Move the slider left  to right to eliminate and extra nodes:  
�
�

�
�
6PRRWK�VPDOO�DQJOH��

�
This option eliminates the corners or points that are in your design.  
 
We recommend eliminating sharp points on a design that will be stick in a car for example. This option will 
avoid that the design unstick during washing. 
 
Choose your design, and then choose the menu 6PRRWK�VPDOO�DQJOH WinPCSIGN will open the 5RXQG�
FRUQHU screen. Enter the angle and radius corners desires. For the example we chose 0.2 for the radius for a 
logo of 2 x 5 inches: 
�

�
�
�
�
�
3DWK�WROHUDQFH��

�
Use this function to obtain a quantity of arcs and / or segments for the images to be vectorize 
�

�
�
�

� �

Depending on the number of curves or segments in 
the image, enter a higher tolerance . 

 
From the dialog box enter a value for arcs and for the 
segments. Confirm by tapping OK. 
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:HOGLQJ�
�

 This function allows you to weld two ort more elements  
             
             ,QWHUVHFWLRQ�

This option allows welding and let the intersections of the elements. From the 6KDSH menu, select  
:HOGLQJ menu: 

���
�

�
�
1RWH��The removed portion will be taken from the first path selected. 
�
 

6XEWUDFW�
This option allows welding and let the difference between of the elements. From the 6KDSH menu, select  
:HOGLQJ menu: 

�

�

�

:HOG�

This option allows you to join two paths that overlap one leaving. From the 6KDSH menu, select  
:HOGLQJ menu: 

  

3URFHGXUH���
�
1-From the 6KDSH menu, :HOGLQJ���,QWHUVHFWLRQ�
 2- Click on 6HOHFW�SDWK. 
 3- Click once on each path from which you want to obtain a   
 union. 

                                 
To accept changes, click on $SSO\. 

�����

 

Procedure: 

The operating window, selects :HOGLQJ/:HOG�then click  
6HOHFW�SDWK. With the help of the mouse click on the 
object  that you want to weld,(1)  and click the other 
path WinPCSIGN will automatically apply your welding 
 

 

Procedure: 
 
The operation window, select 'LIIHUHQFH�6XEWUDFW 
and click 6HOHFW�SDWK. Then with the help of  the mouse click on the 
object that you want to create the difference (click 1), and then click the 
other (clic2) WinPCSIGN automatically apply your intersection 
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6KDGRZ�
This option lets you to create a shadow to a selected path. From 6KDSH menu, click :HOGLQJ menu  

 

 

 

:<6L:<*�&XWWLQJ�WUDQVIRUPDWLRQ
�

This function allows you to prepare a design with that contain crossed lines, open point, individual segments 
etc. That cannot be filled with colors. This function will weld all open points; create double lines by removing 
all unnecessary items and more. See the example:

 

�

3DWK�VSOLW

This function allows you to divide your selection into two halves 

Select your installation, then choose. WinPCSIGN will automatically apply the function 

�

�
3DWK�FOHDQLQJ��(UDVH�GXSOLFDWH�DQG�LQWHUVHFWLRQ

This function allows you to remove LGHQWLFDO�SDWKV or inner�ORRSV in a import montage.  
 
We recomment to use this function the with $,��3')�RU�(36 imported from $GREH�or &RUHO. 
 If your file containt doubles path or intersection, the machine will pass several times on the same path 
ripping the material and breaking  the blade. …   

From Operation screen, selects :HOGLQJ/6KDGRZ��then click 
6HOHFW�SDWK. With the help of the mouse, click on the object that 
you want to create a shadow. WinPCSIGN will   automatically open 
shadow configuration screen. 
Select the direction, color; and the shadow thickness (X and Y 
values). You can also add inside shadows. 
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(UDVH�GXSOLFDWH�SDWK�

If you import a file and send it to the cutter, WinPCSIGN will display the following message if your file 
containt doubles path: 

 

Click 2N, then from 6KDSH menu select 3DWK�FOHDQLQJ/(UDVH�'XSOLFDWH�SDWK��WiPCSIGN will show the 
followind screen. Click 2. to delete all duplicate path.  

 

We recommend applying the option %UHDN�DOO from this same menu, because (UDVH�GXSOLFDWH�SDWK does 
not  work with a gruped designs. 
Warning: Duplicate tool (Alt + D) will create duplicates of your selection and place them below your selected 
path. 

 

(UDVH�LQWHUVHFWLRQ�VHFWLRQ�

This function allows you to remove inner loops in a montage.  
Select your design, then click (UDVH�LQWHUVHFWLRQ�section from 6KDSH menu/ 3DWK�FOHDQLQJ 

WinPCSIGN will automatically apply the function: 

�

�

�

� �
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�

�

)LW�REMHFWV�RQ�D�SDWK�
�

From the 'RFXPHQW�%DU, expand 6KDSH�PHQX and select )LW�2EMHFWV�WR�3DWK� 

 

 

1) Select the path and the object(s) to be distributed on the selected path. Star must be on top layer 
2) From the Document Bar, expand Shape menu and select Fit Objects to Path. 
3) Check mark Full Path, the selected object(s) is distributed  automatically on the full path. 
4) Use the sliding button to adjust the distance between objects  or type the desired value. 
If the Full Path box is not activated you have to use the button  
(+) to add one by one objects to the path and the button (-) removes an object one by one.  

 

The other parameters define the distance of the first object added according to the beginning of the path and 
second parameter defines the distance of objects added from the path. 
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6HWWLQJ�PHQX�
�

3HQ� �
�

Pen configuration window: 
 

In the pen section, it is possible to select the type of joints and extremities, the thickness as well as the type 
of line (dotted, dashes) that will be drawn.  

 
-RLQWV�SHQ�����
  

  
 
�

�

�

�
�

�

%UXVK��
�

��������������%UXVK�W\SH�

��

��
                               
 
    

-RLQWV are defined as the zone created by the intersection of two 
segments. Three types of joints are available: 
5RXQG���  The external side of the  intersection is rounded. 
)ODWWHQHG�  The intersection between two segments is cut. 
3RLQWHG���The intersection between two segments is extended to                  
create a pointed tip.  The length of the tip is limited. It is determined 
by the number placed in the box.  A higher  
([WUHPLWLHV� There are three types of extremities available: 
5RXQG�H[WUHPLW\��The segment ends in a circle. 
6TXDUH�H[WUHPLW\�  The segment ends in a square. 
)ODWWHQHG�H[WUHPLW\: The segment ends on the point. 

6ROLG�  Regular cutting line (default) 
.LVV&XW����� Cut and bend option  
 
 

 Pen thickness (Solid) This function allows you to change 
the thickness of the pen.  
 

 This option will automatically return default value 0.003. 

Two types of brushes are available, solid and hatched 

6ROLG��  The color is uniformly spread.  
+DWFKHG��  The object is filled with colored lines.  
 
Different line configurations are available: 
+RUL]RQWDO, Vertical, Diagonal (left to right), 
'LDJRQDO (right to left), 
6TXDUHG (horizontal and vertical), Diagonally squared. 

 
�

 

Round: The outer side of the rounded intersection. 
 
Flattened: The intersection between the two segments is cut. 
 
Pointed: The intersection of two segments is extended by a point. The 
length of the tip is limited, the limit is indicated by the box in the cluster 
to join. The higher the value, the higher the tip will be long 
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6HWXS���
�

Used this option to customize the program.  This window is divided in several tabs. Each tab includes 
specific parameters:   
 

 
 
 
'RFXPHQW�WDE� 
 
This tab contains parameters regarding the document in general.  
�

�
�

 6DYH�WDE��
�
 This tab deals with save parameters.   
 

 
 

  

,PDJH��The See region border option will create a 
dotted line around  the created region to facilitate 
the viewing of the captured or copied region. The 
Copy comment file region option lets the user 
transfer a comment file to the region. 
6HOHFWLRQ��7ROHUDQFH� Enables user to increase or 
diminish the required distance to select a 
manipulation node. To select a node, you must 
place the cursor near the point you wish to select. 
6HOHFWLRQ�*ULG���This enables the user to set the 
grid value. The grid value depends on  the unit of 
measurement selected.  
8QGR��
This option makes it possible to determine the 
number of undo kept in memory.  Default Level 40 
8QGR�LPDJH For optimal speed, you may let 1. 
8VH�ORJR�GDWDEDVH��Activate the database when 
using logos. 
6HH�,QIR���Activates the sponsors slide show. This 
option is not available on demo versions. 
8VH�ORFDO�GLUHFWRU\��We recommend deselecting 
this option if you are using Windows XP. 
5HVHW��Restores parameters to default values. 
                                     

$GG�IRQW�LQ�GRFXPHQW��
This option allow you to include all True Type 
fonts files used when you export or saving the 
document. 
1RWH: Certain TrueType fonts are registered 
and cannot be included when saving. 

�
8VH�FRPSUHVVLRQ�RQ�LPDJH�: This 
function activates, when saving a document, 
the compression of images with 24 bits per 
pixel resolution. The compression level applied 
corresponds to the position of the scroll bar. A 
minimum value corresponds to high quality but 
with increased file size, while the maximum 
value decreases quality in favour of a smaller 
file size.  
$XWR�VDYH��This option allow you to create a 
backup of your job. Select (QDEOH to activate. 
Select also the time. Open 5HFRYHU\ from File 
menu��

�
5HVHW���Restores the default parameters. 
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�������������8QLW�3DJH�WDE� 
�
This tab lets the user modify the units of measurement used as well as the work page  �
�

�
�
�
If you want to change the precision displaying, select it in 8QLW�PHDVXUHPHQW� This selection will appear on 
the screen: H and W  (message bar.) 
�
�
�
�
�
�
1RWH��If your page is visible, you have the possibility of opening the preferences page by double clicking 
the page’s lower right corner. The preferences window will automatically open on the 8QLW�SDJH tab.�
�
�
/LQH�JXLGHV�FRQILJXUDWLRQ��

 
This option lets you add or delete line guides. 

 

�
�

1RWH��<RX�FDQ�SODFH�DV�PDQ\�OLQHV�DV�\RX�ZLVK��
�
You can change the color of line guides by selecting one or more, and click &RORU��
The 6QDS�WR�OLQH option: When objects are moved, they will stick to any line guide they meet.��
7R�DGG�OLQH�JXLGHV�MXVW�FOLFN�ZLWK�WKH�PRXVH�LQ�WKH�UXOHU�DURXQG�ZRUNLQJ�VFUHHQ�

               

$OLJQ�WR�OLQH�JXLGHV�� �
This function will align objects according to line guides selected by user.  Line-guide selection is done by 
clicking it with the left button: 

3URFHGXUH���
1 Select desired elements. 
2 Select�$OLJQ�WR�OLQH�JXLGHV from the Align bar.  

8QLW�RI�PHDVXUHPHQW���Selection of the unit of 
measurement that will be used. 
3DJH���Enables the user to select the work 
page that will be used. It is possible to 
customize the work page. The user can define 
the height and length of the page or select one 
of the predefined pages. The redefined pages 
are available in the scrollable window.   

 
Sing page FRORU. Select a desire a color 
background for your screen  
If you click on the icon representing a SULQWHU� 
you will automatically set the page as being the 
one defined by the printer page. 
 
If click on ��� you can set the precision of your 
unit from .0  to .000000 This value is show on 
right of the screen + & / 
 
8VH�3DJH�MXVWLILFDWLRQ�  Will determine the 
page used in justification. 6LJQ�SDJH is the 
physical dimensions of the page                                                                                            
represented by a (white by default)rectangle or 
square.  
3ULQWHU�SDJH is the region that can be sent to 
the printer (represented by a dotted rectangle). 
See show printer page). 

5HVHW���Restores the default parameters. 

7R�$GG�OLQHV�JXLGH� 
1-From the 6HWWLQJ menu,  select /LQH�JXLGHV. 
2-Once in the Setting Guide line window, enter a 
value for X and Y. 
3- Click on (+). 
�
7R�HOLPLQDWH�OLQHV�JXLGHV��
1- From the 6HWWLQJ menu,  select /LQH�JXLGHV�or 
double click over a lines guide. 
2- Select a guide line, press on ( - )  minus. 
3- To accept, press 2.. 
Press 5HVHW to erase all lines guide. 
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9HFWRUL]DWLRQ�WDE� 

 
              This tab defines the vectorization parameters. 
 

 
 
 
  6QDS�WDE� 

                This tab enables the user to modify snap ( join points ) parameters.          
                            

 
�. 

*ULG��
�

This function allows you resize the grid on the screen. 
 
Select *ULG�option in the Setting screen. Then, in the dialog box enter the desired value. Confirm pointing 2.��
�

�
�
7KLV�IXQFWLRQ�PXVW�EH�VHOHFWHG�IURP�WKH�9LHZ�PHQX��
�

� �

$SSO\�SDWK�RQ�LPDJH���This option will 
superimpose vectorized paths to the image. 

7ROHUDQFH� This option allows you to enhance 
the result of your vectorization. Default values 
Arc 32 Segment 30 

0DNH�FOHDQ�

This option will clean the image before 
proceeding to vectorization. This option will 
slow down processing speed. When scanning, 
some images will contain useless pixels that 
could possibly interfere during conversion. This 
tool will wash away these useless pixels or 
elements, producing superior vectorizing 
results.  
 
5HVHW��Restores the default parameters. 
 

(QDEOH�6QDS�PRGH���Enables the automatic 
snapping of arcs, Beziers, and segments  as you draw 
them. �

�
(QDEOH�6QDS�WR�JULG���Enable the automatic 
snapping of arcs, Beziers, and segments to grid 
points. 

 
7ROHUDQFH�LQ�SL[HOV��Enables the user to set the 
maximum distance (measured in pixels) for automatic 
snapping to occur. 
�
5HVHW���Restores the default parameters. 
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�
3DJH 

 
With this option you can set the format of the work page. 
To use this feature, you must select the 3DJH from Setting menu. Then in the dialog box enter the :LGWK�and 
+HLJKW� Or select a predefined size. You can also choose the color of the page. WinPCSIGN display your 
page on the screen: 
 

 
 
�
:DUQLQJ��7KLV�RSWLRQ�PXVW�EH�DFWLYDWHG�IURP�9LHZ�PHQX�
�
�
8QLW�RI�PHDVXUHPHQW���

 
 

 
 
 
 
 
3ORWWHU�&RGHV���

 
Before proceeding to the configuration this information will be necessary 

 
1) Cutter brand name and model 
2) Type of connection 
3) USB cable or cable supplied with cutter 
4) USB driver. 

 
Select 3ORWWHU�FRGH from 6HWWLQJV�PHQX. WinPCSIGN will open Setup plotters screen.  Then from 
setup screen, click $GG�5HPRYH�
�

  
 
 
 
 
 
 
 

To change the XQLW�RI�PHDVXUH, you must select Unit from Setting menu. 
Then, in the dialogue box select the desired unit: &0��,QFKHV��3RLQWV��
3LFDV�  3L[HOV or 0LOOLOLWUHV. You can also select the precision decimal 
between 0 (zero) and 0.000000. 
This value will be displayed on the screen: 
 

 
 
You can also select the unit of measure each time that you open the 
program or when you select )LOH���1HZ� 

You can also open this screen by 
double clicking  with the mouse 
on the right corner of the current 
page 
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WinPCSIGN will open plotter list: 
 

 
 
 
Locate your plotter, select it and click on the arrow $GG to place the plotter in the visualization windows to 
the right. Finally click 2.�button and select a FRPPXQLFDWLRQ�3RUW 
 
 +RZ�WR�FRQQHFW�\RXU�SORWWHU�XVLQJ�D�VHULDO�FDEOH"��&RP�SRUW��

�
If you use a serial cable between cutter and computer, select the available &RP�SRUW�previously identified in 
:LQGRZV 'HYLFH�0DQDJHU��usually Com1.  

  

If you use a USB to Serial converter  install the driver comes with the adapter, then check the new port in:  
:LQGRZV�'HYLFH�0DQDJHU�3RUW and configure your cutter in WinPCSIGN with the new com port. Usually 
Com1,2,3,4,5,6 etc 

 
Warning: 86%�WR�6HULDO�adapter must be connect to the serial plotter cable and QHYHU to the plotter�

�

� �

After a com port is selected, click on $FFHSW�6DYH�button.  
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+RZ�WR�FRQQHFW�\RXU�SORWWHU�XVLQJ�DQ�86%�FDEOH"
 

If your cutter is configured to a USB port, click the button 6HOHFW�86%�SORWWHU�to select the proper 86%�
SULQWHU�or�)7',�GULYHU�
�

 
 

�
LI�\RXU�86%�GULYHU�LV�QRW�LQ�WKH�OLVW�����

�
A) Insert the Cd-Rom driver  
B) Plug the USB cable   
C) If you don have driver, download driver from web site  

              D) Select 5HIUHVK�button 
E) Download from internet 
              
Click the 2. button to close the USB port selection window and click the $FFHSW�6DYH button. 
 
$WWHQWLRQ��6RPH�)7',�FXWWHU�ZLOO�FXW�WKRXJKW�FRP�SRUW�XVLQJ�86%�FDEOH�
   
Press Accept / Save to exit and start working.  Read chapter Test your equipment 
 

 

3RZHUIXO�FRPSXWHU��2Q�2II�

With this function, you can optimize your computer for maximum performance  

�

)LOO�VHOHFWHG�HOHPHQWV��

This function allows the option of filling (color) 

�

5HVHW�WRROEDUV��

This function allows you to reset toolbars. 
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+HOS�PHQX� 

 
7LS�RI�WKH�GD\��

 
This will open the days Advice screen. This screen opens when you enter the program the first time 

 
 
 If you do not want this screen appears every time, disable the option 6KRZ�7LSV�RQ�VWDUWXS�
�
+HOS�WRSLFV��

�
 Here you will find support information for different applications WinPCSIGN. To open HTML help, select the 
H
e
l
p
 
t
o
p
i
c
 
f
r
o
m
 
t
h
e
  
 
 
Help menu or press )� key: 
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$ERXW�:LQ3&6,*1��

 
Here you will find information on the version and level of WinPCSIGN you. 
 
7UDQVIHU�RI�/LFHQVH��

 
License Transfer WinPCSIGN Basic 2012 without USB dongle 
 
This function allows you to transfer the license of WinPCSIGN Basic 2012 at another computer. 
From the +HOS�PHQX, click 7UDQVIHU�/LFHQVH. The software will automatically reset the license. You can 
install the software to another computer  
 
Note: Basic WinPCSIGN 2012 transfer a maximum of 5 times. 
�������������
0HPRU\��

 

 
Here you will get information about  memory computer , space and the size of exe WinPCSIGN. 
 

 

 
&OHDQ�PHPRU\�

�

This function retrieves the memory used by software functions by retrieving the memory of cancellations and 
recoveries and the registers. 

 

,QWHUQHW��
 

2SHQ�RXU�ZHE�VLWH��
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 +RZ�WR�FUHDWH 5KLQHVWRQH �

 
&UHDWH�5KLQHVWRQH�SDWWHUQV�

�
Automatic distribution of rhinestones to any shape an image�
 
'HVLJQLQJ�IURP�VFUDWFK�LV�YHU\�HDV\�DQG�LQWHUDFWLYH��:LWK�:LQ3&6,*1�3UR��\RX�FDQ�XSORDG�\RXU�RZQ�
LPDJHV��DGG�SULQWHG�RU�EHDGHG�WH[W�DQG�JUDSKLFV���$GGLQJ�EHDGV�RU�UKLQHVWRQHV�LQ�GLIIHUHQW�VKDSHV��
FRORUV�DQG�VL]HV�IURP�RXU�5KLQHVWRQH�PHQX�� <RX�KDYH�WKH�DELOLW\�WR�PDQLSXODWH�UKLQHVWRQHV�EHDGV��
FRS\��SDVWH���URWDWH��PLUURU��GHOHWH��UHSODFH��FKDQJH            

� 7KH�WUDQVIRUPDWLRQ�UKLQHVWRQH�VFUHHQ�ZLOO�
RSHQ�WKH�IROORZ�IXQFWLRQV��

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

� �

6HOHFW�66�VL]HV�(double click change the 
size of your selection) 
6SDFLQJ�EHWZHHQ�WKH�VWRQH��
2XWOLQH��&HQWHU�OLQH��(Fit to any shape by SS 
size selection). 
*ULG�)LOO�6WDQGDUG�+RUL]RQWDO�9HUWLFDO�VKLIW��
,VODQG��)XOO�RU�3DUWLDO�ILOO�(select Depth).�
6HOHFW�VWRQHV�E\�&RORU�DQG�6L]H��
6HOHFW�SDWK�,QVLGH�2XWVLGH��
6HOHFW�E\�/DVVR��
6SUD\�UKLQHVWRQH�( By SS  selection)��
(Select Spray button).�
'URS�UKLQHVWRQH�E\�FOLFN��
5HVWRUH�&RORU��
&KDQJH�WR�FLUFOH��
6WRQH�WRXFKHG�
&KDQJH�WKH�FRORU�EDFNJURXQG��
'HWHFW�FRUQHU��
(UDVH�2ULJLQDO��
1R�UHVL]H�RQ�RII��
&UHDWH�(Preset rhinestone pattern). 
8VH�3DWWHUQ�(Center, Left, Right, -Random, 
Diagonal more).�
(GLWLRQ�UKLQHVWRQH��
&UHDWH�5KLQHVWRQH�IRQW��
,QIR��
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�
�

6LQJOH�/LQH�5KLQHVWRQH���������������������������� 
 

 How  to write rhinestone text    

   

 
 

 

 

 

 

 

 

 

 

 

 

Step 1  From the Tool Bar on the left side of your working screen, select 7, the Text icon. Once selected, 
the 7 icon becomes depressed; move the mouse on the working page (the cursor is similar to a capital I), 
and click on the place where you wish to begin write your text.               

 Step 2  Type the word “LISA”, the text should appear on your working screen. 
                                        
Step3 Click the Fonts icon )�on the document tool bar to open the Fonts Menu window. 

Step 4 Select a single line font among available selection enter Height 1 inches and pres Ok 

Step 5  By means of the mouse click the selection  tool arrow  in the tools bar at your left, click the text 
which you typed, eight small black boxes appear around your text; this indicates that the object LISA is 
selected. 

                             

Step 6 You have to use more spaces between letters than a normal text we propose you the choice of two 
methods: 9LVXDO�WH[W�VSDFLQJ�or 7H[W�VSDFLQJ from 7H[W�menu 

Step 7  9LVXDO�OHWWHU�VSDFLQJ By using the right arrow, add more space between letters a space of 0,25 
(1/4) inch is recommended. 

              
 By default the space between characters is 12 % of the height use 25 % for letters of 1 inch. 
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Step 8  To reach the Rhinestone window . Click the Rhinestones button from the Bottom Tool Bar:                                                                                    

 
 

Step 9 Apply Rhinestone function to your text.. Select the word LISA, the from Rhinestone screen select SS 
and Spacing. 

   

 

Font: Calypso medium single line Height: 2 inch. 
 
Use these parameters:   

1- Rhinestone beads size is ��66 = 0,2 
2- Spacing between beads is 0,04” this value must be 50% and more of the beads size. 
3- Erase original path is selected 
4-Click Apply button 
5- 66 info button 
this button allows to count total numbers of stones, the total numbers of selected stones and to show the 
size of the used stones. 

 

If you do not like your stones templates press   icon, and start over 
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&RQWRXU�/LQH�)RQWV�
�

Regular Cutting Max fonts and TrueType fonts (Contour fonts) 
 

Step 1 Click the Fonts icon on the document tool bar to open the Fonts Menu window. 
 

Steps 1, 2, 3, 4, 5, 6, 7  
 

From the Fonts  Menu windows select cutting Font button, and use Helvetica Medium. Use 1 inch as 
height and click the OK button. 

 

 

7H[W��/,6$�

Font: Calypso medium  Height: 1 inch. 
Use these parameters:   

1- Rhinestone beads size is 7 SS = 0,02” 
2- Spacing between beads is 0,04” this value must be 50%  and more of the beads size. 
3- Erase original path is selected 
4- Click Apply button:         

Note: If you do not like your stones templates press   icon, and start over 

 

 
� �
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�)LOO�WH[W�ZLWK�5KLQHVWRQHV�
�

7H[W���/,6$�

Step 1 Click the Fonts icon on the document tool bar to open the Fonts Menu window. 
 

Steps 1, 2, 3, 4, 5, 6, 7  
 

From the Fonts  Menu windows select cutting Font button, and use Helvetica Medium. Use 1 inch as 
height and click the OK button. 

�

Funtime Font: Cottage Height: 2.5 inches. 

Use these parameters:  0 
1- Rhinestone size is 12 SS = 0,122” 
2- Spacing between beads is 0,08” this value must be 70% and more of the beads size. 
3- Erase original path is selected 
4- Check Standard from Grid Fill options 

 

 

 

If you do not like your stones templates press   icon, and start over 

� �
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+RZ�WR�DGG�5KLQHVWRQH�WR�D�GHVLJQ�RU�D�VKDSH�
�

Opening a design from ³/RFDO�&OLSDUW´ button. From local Clipart  window  select a desired logo.  

 

For any vector logo as  the heart you can create your own rhinestone model, here is procedure: 

    Select the select element tool, (arrow) click on the heart object t; the eight black handles 
appears. 

From your keyboard press the letter + to open the transformation window. 

        
 
    Click the Rhinestones buton from the Bottom Tool Bar.��

�� �

             �������������
2XWOLQH�UKLQHVWRQHV���

�

 

8VH�WKHVH�SDUDPHWHUV���
1��Rhinestone beads size  is 9 SS = 0,02” 
2- Spacing between beads is 0,06” this value must be 50% and more of the beads size. 
3- Erase original path is selected 
4- Uncheck fill 
5- Click Apply button 

If you do not like your stones templates press   icon, and start over 
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�)LOO�D�ILJXUH�ZLWK�UKLQHVWRQHV
�

�

8VH�WKHVH�SDUDPHWHUV����

1- Rhinestone beads size is 9 SS = 0.02” 
2- Spacing between  0,06” this value must be 70% and more of the beads size when we fill an object 
3- Erase original path is selected 
4- Check mark fill 
5- Click Apply button      
 

/DVVR�
This function allow you select objects from your design using the Bezier tool 

 

  

Choose /DVVR from Rhinestone�6FUHHQ�� With help of the Bezier, draw around the stones, objects or 
design that you want to capture. The selected item will be appear with little white squares,  then press one of 
arrow �8S��'RZQ��/HIW��RU�5LJKW from your keyboard and move them to another position  or press delete 
key. 
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5KLQHVWRQH�DSSOLFDWLRQ��

$SOLFDWLRQ�UKLQHVWRQH�PHWKRG��

Need a vinyl cutter  

Using a vinyl cutter or a scrapbooking cutter cut directly the rubber or plastic stencil material. 
Remove the stencil from it backing and position the stencil on stiff plastic plate, place the stencil 
stuck on the plate in a tray. Pour stones on the stencil and by means of a small brush to scatter 
stones in the holes face upward. Using the Mylar transfer, position it on the stone stencil surface 
and by means of a small squeegee scrape slowly so that stones stick to the Mylar without 
however to the stencil.  

Once made return the Mylar and stones on its backing support for storage or waiting production. 

�
$SOLFDWLRQ�5KLQHVWRQH�PHWKRG��

You need printer: 
 
1) A common printer and paper 
2) A big needle 
3) Pen or pencil 
4) Hot fix applicator 

Use a common printer and paper to print the stencil for the position and  the stones sizes. 

Use a big needle to pierce holes position on the printed paper. Position  of the paper stencil on the material. 
Use a pencil to mark stones position on the material. By means of the hot fix applicator poses the 
rhinestones onto the surface you want to embellish 

               

 
. 

�
�
�
,URQ�RQ�WKH�ILQLVKHG�GHVLJQ�

�
1) Carefully remove the white backing from Mylar sheet 
2) Position the Mylar sheet design onto fabric. 
3) Place Teflon sheet over design. 
4) Set your iron to the proper temperature for the material, and allow iron to heat thoroughly.  
- Make sure that steam is OFF 
- Use “Wool Setting” 
5) Leave iron on design no pressure on and do not move  
iron, let it sit in place for approximately 12 - 15 seconds. Depending on fabric use less time for silks and 
more time for denim large designs, heat one section at a time until all crystals are heated.  
6) Turn fabric over and press gently from the back. 
7)  Allow to cool at least 3 to 5 minutes, slowly remove the Mylar sheet.  
8) When removing the Mylar sheet if some crystals are not firmly attached or feel “loose,” reapply the iron as 
above. 

                                                                                                          
  

 1- Print 
 2- Holes            
 3- Mark on 
 4- Aplicator                   
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+RZ�WR�FUHDWH�FRQWRXU�FXW��
 
A) A simple contour cut 
B) Stuck on the image 
C) Precise distance from image 
 
Import high quality image file 150 to 300 dpi. The background has to be of uniform color rather white, avoid 
multicolored background or gradients. High contrast between background  an image generate good result. 
 
Simple contour cut 
1)  Import an image (JPG, BMP, PNG) 
2)  Use magic wand to create a contour 
 

 
Use the magic wand and click to the left near the image, the vectorisation tool will create automatically an 
outline. Use the sliding cursor Tolerance to adjust your outline. Your outline contains too many segments, 
use the sliding button Smooth to remove segments and generate a smoother outline 

              
Use the sliding button to obtain an outside or inside outline of the  image. When satisfied, click the button 
Add Path. 
 
&RQWRXU�LV�VWXFN�RQ�WKH�LPDJH��
�
1)  Import an image (JPG, BMP, PNG) 
2)  Use magic wand to create a flush contour 
 

�
����������������
���������������:DWFK�D�YLGHR� �
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�

�
Use the magic wand and click to the left of the image. Use parameters 7ROHUDQFH��, 6PRRWK��  and Outline 
0. When satisfied, click the button $GG�3DWK��The path contains many small segments. To show the 
construction points, click the icon & from bottom tool bar. 
 

 
 
 

 

To remove points or useless segments use the  
function VLPSOLI\�SDWK from the 6KDSH menu or from  your keyboard  $OW�3 you can repeat operation 
several times. �

��
&RQWRXU�LV�IRU�D�SUHFLVH�GLVWDQFH�RI�WKH�LPDJH�
 
1)  Import an image (JPG, BMP, PNG) 
2)  Use magic wand to create a flush contour 
3)  Use outline tool to create a precise distance outline or inline 
Use RXWOLQH�WRRO to create a precise distance RXWOLQH 
From the Tools menu select Outline this opens the Transformation Outline window. Select the outline 
created with the magic wand and use the appropriate thickness when done click the checkmark. 
 

  
 

 The new created outline can appear behind your image, 

Use the function 6KDSH�menu�2UGHU to position the outline in the foreground or use the Shift + Home key. 
You can modifythe shape of your outline by using the manipulation tool. 
 
4)  Configure printer 
 
To configure your printer for the printing the page size and page orientation have to be the same. 
 
5)  $GG�FURS�PDUNV 
 
You can optimize your printing work by copying your image and the outline to the page. Function  (GLW and 
0XOWLSO\�(many copies) or the  duplicate function (Alt + D) will be effective tools. 
 
To add the Crop marks, from the File menu, select Crop marks. 
 
Three (3) Crop marks will display on your working page. You can move them by means of the selection tool 
and the mouse or the arrows of your keyboard. Do not forget to save your work before  printing. 
 
Here is the disposition of images and the outlines on the working screen representing a sheet in portrait 
mode. Younotice the presence  of three (3) crop marks the origin crop mark is situated in the lower  left 
corner of the screen. 
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 Every image shows us two (2) outlines. The original outline is close on the image and the second outline       
created by the Outline function  is 1/4” (6mm) of the original outline. Before printing you can erase  the 
outline not necessary for the cut or you can use a function permission to print an object.  
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�

You are ready to print, WinPCSIGN gives you all the necessary tools. From the 9LHZ menu, you can 
display:   Show printer page 
 

 
 

After priting you are ready to cut. To cut with precision thecontour on a printed media you need to use a laser 
registration or a mechanical pointer registration. Cutters can use three (3)crop marks others use two (2) crop 
marks. 

 

   
 

Prepare your cutter and media to cut. Click the Cut Project button.   WinPCSIGN indicates the presence of 
image(s), click &RQWLQXH�to reach cutting control panel. 
  

The 5HJLVWHU icons are shown. Select the icon permission to print when permission is 
denied a red X will  appear on the selected object to indicate that the object not maybe 
printed 

The function which allows not printing an object is activated with the 9LHZ�menu, 
7RROEDU� check mark  5HJLVWHr option and clicks the 2N button. 

From the )LOH menu, you can directly 
reach: 
 
-  Cropmark 
 - Print 
 - Print preview 
 - Print setup 
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 The screen shows only the objects which can be cut. Here we see the presence of two (2) colors and four 
(4) objects.We can cut by selection  of colors or objects. Before cutting we have to click the button 5HJLVWHU�
to calibrate the positionof the laser beam or the pointer. You can use for RedSail and Foison cutters factors 
shown in the table. 
 

 
 

 
The button 5HJLVWHr opens the window Print and Cut Registration. Type the calibration values for your cutter, 
first type the numerical value may position the mouse cursor in front of the numbers to type there the minus 
sign if necessary  3ULQW�DQG�&XW�5HJLVWUDWLRQ�VFUHHQ��

 
 
 

�

�

�

�

�

�

�

�

�

�

� �This is the calibration factors expressed in thousandth  of inch which represents 
distance between the end of  

          
 �

�

�

�

Arrows allow moving quickly the cutter head to position it. 
 

 Check mark the box to obtain a small movement    using the arrows. 
 

The next step button allows moving the cutter head  to different crop marks. 
 

  Movement of the head expressed in thousandth of inch. 
 

�
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�

'HIDXOW�YDOXH�RI�5HGVDLO��60�DQG�'LND�FXWWHU�\RX�FDQ�WU\�

Watch a video; how to get a gap between Head and Laser  

�

                               
                                                                                      

All the training on the calibration and the use of laser beam or mechanical pointer is available on your 
WinPCSIGN CD-ROM program and on our Web site www.signmax.us 
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All trademarks and logos appearing in this program are the exclusive property of each company and 
should be used by authorized persons only. Illegal use is prohibited and may have serious consequences. 

WinPCSIGN Pro, Basic, CNC. Funtime Pro Funtime Scrapbooking, are trademarks of SignMAX Inc. 

Sign Max Enterprises, Inc. 
3745 tricentenaire Blvd. 
Montréal, Québec 
H1B 5W3 
C a n a d a 

 

Phone: (514) 644-3177 
Fax: (514) 644-3173 
 
Site: www.signmax.us 
Site: www.winpcsign.ca 
Email: signmax@signmax.us. 
 

This document was written by : Ivan W. Polanco  
Copyright © 1989-2015  
 MAX Enterprises, Inc. All rights reserved. 


